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Overview 

Welcome to version 8.3 of the IDEXX Cornerstone* Practice Management System! With your help and 
the input of many of the nearly 6,000 other practices in the Cornerstone family, we’ve included 
enhancements and new features in Cornerstone 8.3 software that will improve communications within 
the practice, increasing your efficiency and your ability to provide an exceptional experience for your 
clients. By adding a series of new open-systems integrations, Cornerstone 8.3 will:  

• Improve the data sharing between Cornerstone and your chosen lab and imaging resources. 

• Simplify your ability to communicate via fax or email with referral practices or your clients and track 
those communications. 

• Advance your inventory management capability, ensuring accurate and efficient ordering, receipt, 
and storage. 

• Significantly enhance communication with your clients and ultimately improve their loyalty to your 
practice. 

Thank you for your help in determining what advancements to introduce in Cornerstone 8.3. And as 
always, please share with us any feedback you have on continuing to enhance Cornerstone to better 
meet your needs. 

About This Document 
This document provides information on the new features and functionality in the IDEXX Cornerstone 8.3 
software. It includes key information you’ll need to set up and use these new features and provides 
examples of the new windows available in the Cornerstone 8.3 software. 

Intended Audience 

This document is for experienced users of the Cornerstone software and assumes that you have a good 
working knowledge of an earlier release. If you are new to the software, you should review the reference 
material and training documents available online at idexx.com/cornerstoneresources. 

Note: After installing Cornerstone 8.3, a Cornerstone Administrator must adjust security settings for your 
practice so that staff members can access the new features. See the Cornerstone 8.3 Getting Started 
Guide for a listing of these security settings. 

Documents to Help You Get Started with Cornerstone 8.3 
To help ensure a smooth transition to your new IDEXX Cornerstone 8.3 software, we recommend using 
the Cornerstone 8.3 Getting Started Guide in combination with the Cornerstone 8.3 What’s New Guide. 
Use the sections of the two documents in the order listed on the following page. 
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Plan 

1 Getting Started Guide: 
Preinstallation (sections 1–3) 

1. Review hardware/operating system guidelines. 

2. Review a checklist of preinstallation tasks to prepare for 
and take advantage of the new features in this release. 

3. Review special requirements if you are using a DVD to 
install Cornerstone.  

Install and set up 

2 Getting Started Guide:  
Installation (sections 4–7) Follow the recommended steps for installation. 

3 
What’s New in Cornerstone 8.3: 
Setup instructions at the beginning 
of each feature section 

View detailed information about setting up and using the new 
features and functionality in this release. 

4 Getting Started Guide:  
Security and Setup (section 8) 

Reference this plan to set up security for new features and 
configure default settings. 

Use new features 

5 
Getting Started Guide: 
Communications and training 
(section 9) 

Introduce the new features you choose to implement to your 
practice and train staff.  

6 
What’s New in Cornerstone 8.3: 
Use instructions within each feature 
section 

View detailed information about how to use the new features. 

To access these resources, visit the Cornerstone Resource Library online at 
idexx.com/cornerstoneresources. Copies of both documents are also installed on your computer along 
with Cornerstone. 

 

Training Files 

You can also use Cornerstone tutorial training files data to complete exercises that mimic everyday tasks in 
your practice without jeopardizing the integrity of your real medical records. You can access the training files 
from the Microsoft® Windows® start menu. Select Start > Programs > Cornerstone > Training Files. 
Cornerstone opens, and uses the training files database rather than the live version of the database that 
contains your practice’s information. 

Note: In Windows 8, you can find the Cornerstone folder on the Apps screen. 

In the training files (including the Cornerstone Assistant training files), functionality is limited for some 
Cornerstone 8.3 features which ordinarily communicate with systems outside of Cornerstone: 

• Pet Health Network* Pro—You can see and use Pet Health Network Pro features like the share 
button and the IDEXX Message Center alerts for appointment requests; however, these actions 
won’t be reflected on pethealthnetworkpro.com or petly.com. 

• Inventory Ordering using IDEXX SmartOrder* with MWI® Veterinary Supply—Although you can’t 
use IDEXX SmartOrder, you can view the windows used for working with this feature. Also, Purchase 
Order 1000 in the training files shows an example of a purchase order created using IDEXX 
SmartOrder. 

Cornerstone 8.3 What’s New                  8 

http://www.idexx.com/cornerstoneresources


Overview 

 

• IDEXX Faxing Service—Although you can’t send faxes from the training files with the IDEXX Faxing 
Service, this feature is very close to the new email feature that is usable in the training files. Also, 
completed faxes are shown on the Communications Log in the training files. 

• Antech Diagnostics® Module—A training version of this module is not available in the training files. 
However, training is included when you purchase the Antech module or upgrade from the previous 
version of the module. 
 

• Lifelearn® ClientEd™ Online—You can only set up and synchronize Cornerstone with LifeLearn 
ClientEd Online documents from your live Cornerstone database.  

 
• VetConnect* PLUS—You can view VetConnect PLUS information for the following patients: 

o Zeke—Patient ID 15329 (Feline) 
o Blake—Patient ID 3679K-1 (Canine) 
o Twister—Patient ID 120Q-1 (Canine) 

 
• Electronic signature capture for the integrated payment solution with XCharge®—In the training 

files, you can view XCharge features except the ability to capture electronic signatures. 

• Activation—You cannot activate or set up any of the above features from the training files, only from 
your live Cornerstone database. Also, in the configuration windows for a multi-location single 
database environment, the training files do not allow you to apply primary settings to a secondary 
practice. 
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IDEXX Pet Health Network* Pro 

Communications Management for Email and Fax 

Next Appointment Scheduling Reminder 

Additional Client Information Enhancements 

Linking Documents to Diagnosis Codes 

LifeLearn® ClientEd™ Online Integration with Cornerstone 
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IDEXX Pet Health Network* Pro 

IDEXX Pet Health Network* Pro lets you manage communication to and from your clients right inside the 
IDEXX Cornerstone* Practice Management System.  

The tools available when you use IDEXX Pet Health Network Pro with Cornerstone include: 

• Sending automatic reminders by mail and/or email. 

• Allowing clients to confirm appointments by email or text. 

• Receiving requests for appointments and prescriptions from clients on the Petly* website, as well as 
receiving updated client information. 

• Sharing selected documents from the patient record with clients electronically. 

Your clients interact with IDEXX Pet Health Network Pro through email, text messages, and the 
personalized pet pages at Petly.com. Petly.com contains individual online pet pages that provide 
important updates and an engaging way for pet owners to view pet health information, request 
appointments, and refill prescriptions. 

Setup 

Activate and Set Up IDEXX Pet Health Network Pro 
Before you use the new IDEXX Pet Health Network Pro features in Cornerstone 8.3, you need  
to sign up for the service. Get started by contacting an IDEXX Pet Health Network Pro communications 
specialist at 1-855-627-6570 or support@pethealthnetworkpro.com. The specialist will walk you through 
the set up of IDEXX Pet Health Network Pro for your practice. The setup steps for some key features are 
outlined below, and you can find more detailed guidance on each IDEXX Pet Health Network Pro screen. 

Note: IDEXX Pet Health Network Pro is a subscription-based service. There is also a charge for postcard 
communications. Contact IDEXX Pet Health Network Pro for subscription information. 

Set Up Reminders on IDEXX Pet Health Network Pro 
You can set up email and/or postcard reminders that will be sent automatically to clients a specified 
number of weeks before a patient is due for an appointment. Email reminders allow clients to confirm the 
appointment electronically. 

To set up reminders: 

1. Log in to IDEXX Pet Health Network Pro, and click Communications and Medical Reminders.  

2. On the Medical Reminders screen, fill in the information in the Schedule and Options areas. 

3. If necessary, click the edit links to edit the design of postcards and email messages. 

4. When you have finished setting up reminders, log out of IDEXX Pet Health Network Pro and close 
your browser window. 

Set Up Appointment Request and Pharmacy Request Options 
When you have IDEXX Pet Health Network Pro, you can give your clients the ability to request 
appointment times from their account on Petly.com. You can also give them the ability to request 
prescription refills from Petly.com. Cornerstone displays these requests so that you can schedule the 
appointment or refill the prescription based on the information the client sends. 
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To set up appointment request and pharmacy options: 

1. Log in to IDEXX Pet Health Network Pro, and click Petly.  

2. Fill in the information in the Appointment Requests and Prescription Requests areas. 

3. When you have finished completing the information, log out of IDEXX Pet Health Network Pro and 
close your browser window. 

Set Up Missing Client Email Alert Options 
IDEXX Pet Health Network Pro uses the client email information stored in Cornerstone to send out 
reminders, confirmation requests, and invitations for clients to join Petly.com. To help ensure that email 
information is obtained, a new missing email alert has been added to Cornerstone and is on by default. 
You can configure how this alert is displayed and whether it is displayed at all. The alert is displayed on 
the Patient Clipboard and in the Client Alert window.  

To set up the Missing Client Email Address alert: 

1. On the menu bar, select Controls> Defaults> Practice and Workstation, and then select Alerts in 
the navigation pane. 

2. Make sure that Missing Client Email Address is selected. 

3. Click Save to save your changes. 

Use 

View Incoming Client Requests and information via the IDEXX Message Center 
If a client uses Pet Health Network Pro to send a request for an appointment or prescription refill or to 
update client information, you can view that information from the IDEXX Message Center in Cornerstone.  

To view and act upon client requests and information: 

1. On the Cornerstone toolbar, click the IDEXX Message Center 
 button.  

2. Click the Client Messages tab.  

3. Click the appropriate subtab: 

• Appointment Requests 

• Prescription Requests 

• Client Updates 

Each tab displays a list of messages. Messages in black are 
unread. If there is more information than the message center 
can display at one time, use the arrow buttons at the bottom of 
the window to move forward and back through the pages. If 

you want to update the list of messages, click Refresh . 

4. To open a message, double-click it.  

OR 

To act on more than one message, hold down the CTRL key 
and click each message you want, then right-click and select Open. 
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A dialog box displays each selected appointment request, prescription request, or client update. 

  

5. If you want to copy text from the message, highlight it and press CTRL+C. To paste this text in a text 
box elsewhere in Cornerstone, click inside the text box and press CTRL+V.  

6. To open the Patient Clipboard so that you can schedule the appointment, enter the prescription 
refill, or make updates to client information, click the Patient Clipboard link in the lower right of the 
dialog box. 

Additional Message Center Tips 

• The IDEXX Message Center lists all recently returned results from IDEXX Reference Laboratories and 

IDEXX VetLab* Station. Click the IDEXX Message Center  button on the toolbar to open the 
window, and then click the Lab Results tab. The button appears in red and black when there are 
unread messages. 

• The number of messages in each tab and subtab appears in brackets next to the tab or subtab 
name. 

• Client messages are bold black when they are unread, and light gray after you have read them.  
Tip: If you want to turn a read message back to its unread state, right-click it and select Mark as 
unread. 

• Once a message has been deleted, it is gone from Cornerstone and cannot be retrieved; however, 
you can keep messages indefinitely if you choose. 

Automatic Appointment Confirmations through IDEXX Pet Health Network Pro 
If you set up email reminders in IDEXX Pet Health Network Pro, the reminder includes a button that the 
client can use to confirm the appointment. Also, if the client visits Petly.com within a specified number of 
days before the appointment, a reminder will appear, and this reminder also includes a Confirm Your 
Appointment button. 

When the client confirms the appointment, the confirmation is recorded on the Edit Appointment dialog 
box for that appointment. Next to the confirmation date, Cornerstone shows that the appointment was 
confirmed by IDEXX Pet Health Network Pro (displayed as “PHN Pro”). 

Note: If you need to clear the Confirmed on text box, click Unconfirm, just as you would if you entered 
the confirmation date manually. 
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Share Documents with Clients 
With IDEXX Pet Health Network Pro, you can share the following documents with clients electronically: 

• Medical notes (enhanced format) 

• Medical notes (text only) 

• Correspondence (enhanced format) 

• Correspondence (text only) 

You have the opportunity to add a personal message that will appear with the document on the client’s 
page at Petly.com. Once a document is shared, you cannot remove it from the client’s page at 
Petly.com. 

Note: You can also share laboratory results and client-friendly reports from IDEXX VetConnect* PLUS 
within Cornerstone. 

To share a document: 

1. In the Cornerstone Editor, while looking at a medical note or correspondence document that is in the 
Final state, click Share. 

Note: Documents in a state of Tentative cannot be shared. 
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The IDEXX Pet Health Network Pro—Sharing dialog box appears. 

 

2. Enter your staff ID and the message that you want to appear with the document. 

3. Click OK. The document will appear on the client’s Petly.com page within a few hours. 

Seeing What You’ve Shared 

When you share a document, Cornerstone displays when and by whom a document was shared in the 
following locations: 

• On the Medical Note window, in the Hx Description line  

• On the Patient Clipboard*, on the Summary and Medical Note tabs 

• On the Check-in Report (either by date or by type), in the history line 

Note: Laboratory results and client-friendly reports that you share from IDEXX VetConnect PLUS within 
Cornerstone can be viewed from the VetConnect PLUS communications log but are not viewable 
elsewhere in Cornerstone. 

New Features to Record Client Email Addresses 
IDEXX Pet Health Network Pro uses the client email information stored in Cornerstone to send out 
reminders, confirmation requests, and invitations for clients to join Petly.com. To help ensure that email 
information is obtained, some changes have been made to the Client Information window: 

• If the Email address text box is empty, it is highlighted. 
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• If the client does not want to give his or her email address, select the Email declined check box. 
This turns off the highlight on the Email address text box and turns off missing email address alerts 
for this client (if you have set up missing email alerts). Also, Cornerstone displays the date on which 
the client declined to provide their email address (the date you check the box). 
Note: For more information about setting up missing email alerts, see “Set Up Missing Client Email 
Alert Options” on page 12.  

 

 

 

 

 

 

 

 

 

 

 

Viewing IDEXX Pet Health Network Pro Activities on Reports 
Information about activities related to IDEXX Pet Health Network Pro has been added to some existing 
reports: 

 The Patient History Report and the Check-in Report show when a document was shared, and 
who shared it. 

Additional IDEXX Pet Health Network Pro Features 
IDEXX Pet Health Network Pro is updated independently of Cornerstone. From time to time, new 
features may be available in IDEXX Pet Health Network Pro even though you have not upgraded your 
Cornerstone software. Check pethealthnetworkpro.com periodically to learn about these new features. 
After you have activated IDEXX Pet Health Network Pro, you can see additional information about new 
features on your practice’s IDEXX Pet Health Network Pro Home page (go to 
pethealthnetworkpro.com/login and sign in). 
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Communications Management for Email and Fax 

Overview 
The new Communications Management features offered in IDEXX Cornerstone* 8.3 Practice 
Management Software allow for outbound email and fax communications tied directly to a patient record 
and recorded in patient history. These improved communication tools allow you to easily share patient 
information, particularly when interacting with specialty, referral, and emergency facilities. When you 
initiate these communications within the Cornerstone software, steps are cut out of the workflow so that 
staff members can spend less time on administrative tasks and more time helping clients and patients. 

Improvements include: 

• The ability to fax estimates, medical notes, and correspondence documents. 

• An improved Communications window to email medical notes, correspondence documents, 
and estimates directly from the Cornerstone Editor. 

• The ability to link an SMTP email account to current email functionality for medical notes, 
correspondence documents, and estimates. 

• The ability to send an attachment to a medical note or correspondence along with the medical 
note via email or fax.  

 
Communications window 

In addition, the new Communications Log allows you to track all outbound email and fax 
communications and all associated details. 
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Tip: These new communication options are especially useful for specialists in all disciplines who need to 
manage communications and relationships with referring veterinarians (RDVMs). 

Setup 

Email Setup 
To activate Communications Management email features in Cornerstone 8.3, you may need to perform a 
one-time setup to specify your account information.  

To access Login/Password Management settings: 

1. On the menu bar, select Lists > Practice. The Practice List dialog box appears. 

2. With your practice name selected, click Update (or double-click the practice). The Practice 
Information dialog box appears. 

3. On the Practice Information window, in the Login/Password Management area, select 
Communications – Email from the Account information for drop-down list. 

4. Select one of the following Email Service options you prefer to use when emailing from Cornerstone: 

• My desktop email client (such as Microsoft Outlook)—Select this option if you plan to use your 
existing email software. 
Note: This will already be selected if you are using your existing email software. You must have 
properly configured email software to use this option. 

• Cornerstone Imaging SMTP email settings (web-based email, like Gmail™, Hotmail®, etc.)—
Select this option if you want to use the SMTP email set up in Imaging defaults.  
SMTP email is tied to the staff user name under which you are logged in. You can set up one 
SMTP email account for each staff user name and one SMTP email account to cover any user 
names that don’t have their own account. 
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IMPORTANT: To complete setup, you’ll need to have information about your SMTP account 
available (such as the SMTP server name and port number). You can get this information from 
your email provider. 

To view and edit current settings: 

1. Follow the steps in the previous procedure. In step 4, select Cornerstone Imaging SMTP email 
settings. 

2. Click the edit imaging SMTP settings link to open the Imaging Configuration window and click 
Email to view the default settings.  

3. To set up an SMTP account for the logged-in staff member, select the tab with that name. To set up 
an account for any staff who don’t have an SMTP account set up, select the System tab. 

4. Fill in the Email Account and Email Defaults areas. For more detailed information on SMTP settings, 
press F1 to display the help. 

5. Click Save to save and close the Imaging Configuration window. 

Fax Setup 
To activate IDEXX Faxing Service, you must be an administrator or be provided administrative rights and 
complete the activation setup process below. For more information on the IDEXX Faxing Service, 
contact Cornerstone Support at 1-800-695-2877. 

To access Login/Password Management settings: 

1. On the menu bar, select Lists > Practice. The Practice List dialog box appears. 

2. With your practice name selected, click Update (or double-click the practice). The Practice 
Information dialog box appears. 

3. On the Practice Information window, in the Login/Password Management area, select 
Communications – Fax from the Account information for drop-down list. 

4. Select the Use IDEXX Faxing Service check box. A pop-up box displays the terms and conditions 
of use.  

5. Review the terms and click Accept to activate the service. 
Upon successful activation, the system will log the user who enrolled the IDEXX Faxing Service. In 
the Practice Information window, the name, time/date stamp, and a link to the IDEXX Faxing terms 
and conditions are displayed. Note that all practices in a Multi-Location Single Database 
configuration must accept the terms and conditions. 

Note: There is an initial setup fee of $29.95 associated with this service, as well as a use fee of $0.10 per 
page that IDEXX invoices monthly. 

To terminate IDEXX Faxing Services: 

1. On the menu bar, select Lists > Practice. The Practice List dialog box appears. 

2. With your practice name selected, click Update (or double-click the practice). The Practice 
Information dialog box appears. 

3. On the Practice Information window, in the Login/Password Management area, select 
Communications – Fax from the Account information for drop-down list. 

4. Clear the Use IDEXX Faxing Service check box. 

5. Click OK when you are prompted to confirm your intent to terminate the service.  
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To reactivate IDEXX Faxing Services: 

 If you have previously activated and then terminated the IDEXX Faxing Service, follow the 
instructions for initial activation and enrollment, select the Use IDEXX Faxing Service check box, 
and follow the same steps involved in the initial activation.   

Note: You must agree to the terms and conditions again and will be subject to the activation setup fees 
agreed to in the terms and conditions. 

Setting Check-In Report Print Options for Communications 

To set Check-in Report print options for Communications: 

1. On the menu bar, select Controls > Defaults > Practice and Workstation. 

2. In the navigation pane on the left, click Check-in and then click Check-in Print Options. 

3. If you want Communications (email/fax) information to print on the Check-in Report, select the 
Communications check box and then specify the range of information to print (All, Last month, Last 
3 months, etc.). 

4. When you are finished, click OK. 

Use 

Emailing or Faxing Documents from the Cornerstone Editor 
You can send a medical note, correspondence document, or estimate to a client and/or referral 
veterinarian (RDVM) by email and/or fax directly from the Cornerstone Editor. The Send Document 
window reflects communication preferences for any recipients set up in Cornerstone. When emailing a 
medical note, correspondence document, or estimate from the Cornerstone Editor, a PDF of the 
document is automatically created and attached to the email.  

Note: The method used to email from Cornerstone depends on the Email Service setting selected in 
Practice Information for the currently logged in practice. 

To send a document from the Cornerstone Editor: 

1. With the document open in the Cornerstone Editor, click Email/Fax or select File > Send 
Document. The Communications window appears. 
Note: Communication preferences set up in Cornerstone for clients and RDVMs are reflected on this 
window. 
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Example: If Dr. Smith is listed as an RDVM for this patient in Patient Information and Dr. Smith’s 
communication preference of receiving information via email has been set up in Cornerstone, the 
Email check box is automatically selected and the associated email address displays in the email 
Recipients list. If an RDVM is marked as the Primary for this patient, the To: email type is selected 
(unless the This visit check box on the Referrals tab on the Patient Information window is cleared). 
If another RDVM is marked as This visit for the patient, the CC: email type is selected. If the RDVM 
does not have communication preferences set up in Cornerstone, they will not automatically appear 
in the list even if they are the primary RDVM or if the This visit check box is selected on the 
Referrals tab of the Patient Information window.  

2. In the Staff field, type the ID, press F2, or select the staff member from drop-down list. (Defaults to 
last staff used on the workstation.)  

3. If you want to send the document in PDF format by email, select the Email check box and do the 
following in the Communication Type and Recipients area: 

a. In the Subject text box, use the default subject line that displays or type in the text box to edit 
the subject line. 

b. If the client associated with this document has an email address set up in Client Information, 
you can quickly add the client to the email Recipients list by selecting the Add client check 
box. Cornerstone automatically lists the associated name and email address for the client. 

c. In the email Recipients list, double-click in the Type field and select one of the following for 
each recipient: 

• To: Select this email type for all primary recipients of the message. At least one recipient 
must be designated as a To recipient.  

• CC: CC is an abbreviation for “carbon copy.” If you select the CC type for a recipient, a 
copy of the message is sent to that recipient. All other recipients of that message can see 
that the person you designated as a CC recipient has received a copy of the message. 
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• BCC: BCC is an abbreviation for "blind carbon copy." If you select the BCC type for a 
recipient, a copy of the message is sent to the recipient, but the recipient's name is not 
visible to the other recipients of the message (including other BCC recipients). 

d. If you want to email the document to a recipient not currently set up with an email address in 
Cornerstone, in the next available blank row in the Recipients list, complete the Name and 
Email Address fields. You can change the email type by selecting To:, CC:, or BCC: from the 
Type drop-down list.  

e. To remove a listed recipient, in the email Recipients list, click the Remove icon in the 
applicable row. 

4. IDEXX Faxing Service only: If you want to send the document by fax, select the Fax check box and 
do the following in the Communication Type and Recipients area: 

a. If you want to include a fax cover sheet with the document, select the Include Cover Sheet 
check box. Any text entered in the Message text box is included on the cover sheet.  
Note: If you use a logo on your printed invoice, that logo is also applied to your fax cover sheet. 

b. If you want to fax the document to a recipient not currently set up with a fax number in 
Cornerstone, in the next available blank row in the Recipients list, complete the Name and Fax 
Number fields.  

c. To remove a listed recipient, in the fax Recipients list, click the Remove icon in the applicable 
row. 

5. You can enter text in the Message text box. This text will be included in the body of the email or the 
fax cover sheet. 

6. The Attachments list automatically includes the document being sent in this email or fax 
transmission, as well as any files that are attached to the document. These appear on the 
Attachments tab. Most common file types are supported, including PDF, CSV, GIF, JPG, JPEG, XLS, 
DOC, TIF, TIFF, etc.  

Note: In the Attachments list, for both a medical note (the document currently open in the 
Cornerstone Editor) and correspondence documents, the Type is listed as Medical Note 
Attachment. 

To work with attachments, do any of the following: 

• To view an attachment in a separate preview window, click the View icon in the applicable row. 

• To remove an attachment so it is not included with the email or fax, click the Remove icon in the 
applicable row. 

7. Click Send to send the document and any selected attachments to the specified recipients. 

Viewing Communications in the Patient Clipboard 
When you send email or fax communications from Cornerstone, a line for each communication type is 
generated in patient history and is viewable from the Patient Clipboard Summary and Text tabs. Email 
and fax communications also display on the Summary and Text tabs in the Patient File window. 

Note: If you do not want email and fax communication lines to display in patient history or on the 
Summary or Text tabs, right-click a column heading, select Filter, and deselect the Communications 
option. 
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Preview Pane Display 

With a communication line selected on the Patient Clipboard Summary tab or Text tab, click Preview to 
view Recipients, Attachments, Subject, and Message information in the preview pane. 

Viewing the Communications Log 
All email and fax communications sent from Cornerstone are tracked in a Communications Log, which 
provides comprehensive details on the date sent, transaction status (sent/failed), recipient, destination 
(email address or fax number), patient, and so on.  

The Communications Log window allows you to: 

• View all outbound email and fax communications initiated from Cornerstone during a specified date 
range. 

• View the communication type (email or fax), client/patient, staff associated with the communication, 
the subject, and the date the email or fax was sent. 

• View all recipients of the communication and the status of the email or fax transmission. 

• Resend a failed transmission. 

• View the file name, type, and a preview for all attachments included in the email or fax. 

• Show only communications related to a specific communication by clicking Show Related Rows.  

• Mobile Computing module users can view the communication history type (communication) in the 
Patient Clipboard Summary tab. 

You can also: 

• Change the way the log is sorted by clicking on a column header; an arrow marks the column and 
indicates the sort order (ascending or descending). 

• Select the Only failed rows not successfully resent check box to display only failed emails and 
faxes that have not been successfully resent. 

• Export the information shown in the log to a CSV file that can be opened in another software 
program. 

Note: Laboratory results and client-friendly reports that are emailed from IDEXX VetConnect* PLUS 
within Cornerstone can be viewed from the VetConnect PLUS communications log but are not viewable 
elsewhere in Cornerstone.  

Accessing the Communications Log 
• To view all practice communications, on the menu bar, select Activities > Communications Log. 

• To view all communications for a specific patient, click the view communication log link in the 
Patient Information area on the Patient Clipboard. 

• To view a specific communication and all communications related to it, double-click the 
communication line in the Summary or Text tab on the Patient Clipboard or click the 

Communication  button. 
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A new reminder has been added to help make sure that clients schedule their next preventive care 
appointment before they leave your practice.  

You can set up the feature to display all reminders; however, many practices prefer to have Cornerstone 
display reminders only for certain invoice items. 

Setup 
To set up the next appointment scheduling reminder: 

1. On the menu bar, select Controls> Defaults> Practice and Workstation Defaults, and then 
select Appointment Scheduler in the navigation pane on the left. 

2. In the Next Appointment Reminder Messages area, the Display next appointment reminder 
messages check box is selected by default. If you don’t want appointment reminders to appear, 
clear this check box. 

3. To display messages only for certain invoice items: 

a. Select the Only display messages for invoice items in the list below check box.  

b. To fill in the list with the invoice items for which you want a reminder, enter the invoice item ID in 
an empty Item ID box or select an empty box and press F2 to select from a list. 

4. When you finish, click OK. 

Use 
When you post an invoice, Cornerstone displays the next appointment reminder for each patient who is 
on the invoice. If there’s more than one reminder for a patient, Cornerstone displays the earliest one. If a 
reminder is overdue, it will still appear. 

 
These reminders include letter reminders that you can currently view in Cornerstone. If you set up the 
feature to only display reminders for certain invoice items, Cornerstone will display only those reminders.  

If you schedule an appointment using the reminder, that appointment will be printed on the invoice. 

Note: The Next Appointment Reminder dialog box displays reminders for all of the patients on the 
invoice, but the automatic scheduling feature takes you to the schedule for only the first patient listed.  

To schedule an appointment using the reminder: 

1. On the Next Appointment Reminder dialog box, select Yes. The Appointment Scheduler window 
appears and displays the schedule for the date the reminder is due. If the reminder is overdue, the 
schedule displays tomorrow’s schedule. 
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2. Right-click the time you want and select Schedule to begin scheduling the appointment. The 
Schedule Appointment for the Following dialog box appears. 

3. Click Yes. The New Appointment window opens. 

4. Fill in appointment information, and click OK.  
Note: Be sure to check the Reminders list, since the patient may have reminders for several 
services that are due the same day. 
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Additional Client Information Enhancements 

Setup 

Set Up Missing Client Email Alert Options 
To help ensure that email information is obtained, a new missing email alert has been added to 
Cornerstone.  

You can configure how this alert is displayed and whether it is displayed at all; it is on by default. The 
alert is displayed on the Patient Clipboard and in the Client Alert window. This alert is on by default. 

To set up the Missing Client Email Address alert: 

1. On the menu bar, select Controls> Defaults> Practice and Workstation, and then select Alerts in 
the navigation pane. 

2. Make sure that Missing Client Email Address is selected. 

3. Click Save to save your changes. 

Use 

New Features to Help Record Client Email Addresses 
IDEXX Pet Health Network Pro uses the client email information stored in Cornerstone to send out 
reminders, confirmation requests, and invitations for clients to join Petly.com. To help ensure that email 
information is obtained, some changes have been made to the Client Information window: 

• If the Email Address text box is empty, it is highlighted. 

• If the client does not want to give his or her email address, select the Email declined check box. 
This turns off the highlight on the Email Address text box and turns off missing email address alerts, 
if you have set them up. Also, Cornerstone displays the date on which the client declined to provide 
their email address (the date you check the box). 
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Appointment confirmations shows staff who entered confirmation 
On the Edit Appointment dialog box, when you enter a date in the Confirmed on text box, your staff ID is 
displayed after the date.  

If you click Unconfirm to clear the Confirmed on text box, your staff ID is removed as well as the 
confirmation date. 

Note: If you are using IDEXX Pet Health Network Pro and a client confirms an appointment on their 
Petly.com page, “By PHN Pro” is displayed in place of a staff ID. See “Automatic Appointment 
Confirmations through IDEXX Pet Health Network Pro,” on page 13 for more details. 
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Similar to the option of printing a document upon checking in or checking out a patient based on the 
reason for the visit, you can now link one or more documents to a diagnosis code so that the document 
automatically prints when the diagnosis is entered in a medical note. This option is especially useful for 
linking a specific client handout document to a particular diagnosis so that the handout prints 
automatically and is ready to discuss and pass on to the client. 

Tip: If you have purchased and set up LifeLearn® ClientEd Online™ documents for use with 
Cornerstone, these diagnosis-specific client handout documents can be linked to diagnosis codes.  

Setup 

Linking Documents to Diagnosis Codes 
You can link documents to a specific diagnostic code in the Diagnostic Code Setup window. 

To link documents to diagnostic codes: 

1. On the menu bar, select Lists > Diagnostic Codes. 

2. On the Diagnostic Codes dialog box, select the applicable diagnostic code and click Update. The 
Diagnostic Code Setup dialog box appears. 

 

3. In the Documents area, in the next available Doc ID field, double-click or press F2 to search for and 
select a document template from the Document Template List. 

4. Repeat step 3 as needed to select all applicable documents to be linked to this diagnostic code. 

5. Click OK. 
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Use 

Automatically Printing a Linked “Diagnosis Document” from a Medical Note 
The Diagnosis Document dialog box appears if you add a diagnosis to a patient record, either from the 
Patient Clipboard or through a medical note or correspondence, 
and you insert a diagnosis code that has been preconfigured to 
link to a particular document in Cornerstone. 

If you click Yes to print the linked diagnosis document, the Staff 
Selection dialog box appears.  

After you enter the staff ID, one of the following will happen: 

• If the linked diagnosis document is a medical note or 
correspondence document:  

• If the document is a print-only document with no entries 
to fill out, the document prints automatically on the 
default printer. 

• Otherwise, Cornerstone opens the document so that 
you can print it. 

• If the linked diagnosis document is a LifeLearn® client handout, the document opens in Microsoft® 
Word. You can then print the document directly from Microsoft Word. (See the “LifeLearn® ClientEd 
Online™ Integration with Cornerstone” section that follows for more information on LifeLearn 
documents.)
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With earlier versions of Cornerstone software, LifeLearn® client education handouts could be purchased 
on CD and integrated with Cornerstone through a one-time document import process. In Cornerstone 
8.3, through a subscription to the LifeLearn ClientEd Online™ web-based portal, Cornerstone users can 
experience the added flexibility and convenience of having continually updated articles that can be 
customized and edited as often as you like, with new articles added regularly.  

LifeLearn ClientEd Online allows you to: 

• Access an extensive library of over 1,200 fully searchable, illustrated, educational titles that you can 
email, print, or save. 

• Add or replace content within any article with an easy-to-use content management system (CMS). 

• Add your own articles to your custom library. 

• Personalize articles to your specific patients. 

• Reinforce your online presence and turn your website into a knowledge center.  

• In Cornerstone, link content directly to diagnostic and treatment codes for automatic printing and 
storage in your patient’s medical records. See “Linking Documents to Diagnosis Codes” on page 28 
for more information. 

After activating the ClientEd Online service through LifeLearn and performing an initial document 
synchronization, ClientEd Online documents are available for selection within the Cornerstone 8.3 
software.  

For more information on LifeLearn ClientEd Online, visit  
lifelearn-cliented.com/about_cliented or contact your IDEXX Cornerstone Sales Representative at  
1-800-283-8386. 

Note: Using LifeLearn ClientEd Online documents requires Microsoft® Word 2003 or newer.  

Setup 

Getting Started with LifeLearn ClientEd Online 
Both new and existing LifeLearn customers must subscribe to the ClientEd Online service. Please 
contact your IDEXX Cornerstone Inside Representative at 1-800-283-8386 for more information.  

Once you have completed the sign-up process and received your LifeLearn username and password, 
you can then perform the synchronization in Cornerstone to begin printing your ClientEd Online client 
handout documents. 

Notes:  

• If you currently use CD-based LifeLearn documents with Cornerstone, rest assured that any existing 
documents you may have customized or edited will not be overwritten during the sync process in 
Cornerstone. 

o To avoid duplicate templates in the template list, delete any CD-based LifeLearn documents 
that you no longer want to use. From the toolbar, select Lists > Documents to review and 
delete templates before you synchronize. 
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o If you had special actions set up with CD-based LifeLearn documents (for example, to 
automatically print), change the special actions to link them to the online documents. 

• There is a one-time user license fee associated with ClientEd Online, as well as a monthly 
subscription fee. 

Synchronizing LifeLearn ClientEd Online Documents with Cornerstone 8.3 
Upon activation of the ClientEd Online service with LifeLearn, in Cornerstone select Tools > 
Synchronize LifeLearn Documents.  

 

On the LifeLearn ClientEd Sync dialog box’s Account tab, enter your LifeLearn account username and 
password in the fields provided. Leave all other fields at their default settings, and click Sync Now to 
update Cornerstone with the latest documents available. Once the first synchronization is run, you can 
then return to this dialog box at any time to sync and receive any new documents or edits in your online 
library. 

Note: Depending on the speed of your Internet connection and transfer rate, the synchronization 
process may take a long time the first time you sync all documents with Cornerstone. Consider doing 
your initial sync during a time that you do not need to use that server, as it will be dedicated to the sync 
process. 

Use 

Customizing and Editing Your Library of ClientEd Online Documents 
LifeLearn ClientEd Online provides you with the added flexibility to edit the handouts and to ensure 
consistency of the handouts across your practice. You can: 

• Edit the handouts as often as you like.  

• Customize any document to reflect your practice’s philosophy, style, or culture.  

• Add your own articles to your library.  

• Access a record of the edits made, date of the edit, and who in your practice has made the edits.  
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Any edits made in your online library will be retained and reflected the next time you sync your LifeLearn 
ClientEd Online documents in Cornerstone. 

Note: You will receive detailed instructions on editing and customizing your library of documents when 
you sign up for the ClientEd Online service with LifeLearn. If you have questions about editing and 
customizing LifeLearn documents, contact LifeLearn Customer Support at 1-800-375-7994 option 2. 

Selecting a LifeLearn Document from the Start New Document Window 
Using the enhanced Start New Document window in Cornerstone 8.3, you can search for a LifeLearn 
document by keyword, species, topic, and/or system.  

Note: LifeLearn documents do not display in the Preview pane like other document templates because 
LifeLearn documents are Microsoft® Word documents. 

 
Select the desired document and click OK to open the document in Microsoft Word with predefined 
practice and patient demographics included in the appropriate fields within the document. 

Note: Microsoft Word is required to print LifeLearn documents that include your Cornerstone practice 
information and patient demographics.  

Other Ways to Use LifeLearn ClientEd Documents with Cornerstone  
In addition to accessing LifeLearn documents on the Start New Document window, these documents 
can also be linked to certain actions in Cornerstone to streamline your client communications and 
automatically print client handouts. 

In Cornerstone, you can link documents to: 

• An invoice item, using the Print Document special action. 

• A reason for visit. 

• A diagnosis code (see “Linking Documents to Diagnosis Codes” on page 28 for more information). 

Note: Mobile Computing module users in the field will not be able to sync LifeLearn documents but will 
be able to search for them. 
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VetConnect* PLUS 

IDEXX VetLab* Station 

Antech Diagnostics® Module 

Miscellaneous Laboratory Enhancements 
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Overview 
Version 8.3 of the IDEXX Cornerstone* Practice Management System, excluding the Mobile Computing 
module, includes optional access to VetConnect* PLUS, a powerful web-based tool that lets you view 
and compare IDEXX in-house diagnostics and IDEXX Reference Laboratories data side by side. 

VetConnect PLUS works within the standard Cornerstone workflow for viewing results and has an 
enhanced format for viewing, comparing, and graphing result data. You can also visit 
vetconnectplus.com to view your results in a browser.  

Here’s an example of a VetConnect PLUS tab. 

 
Using VetConnect PLUS, you can: 

• View the latest IDEXX test results in an enhanced and interactive window as soon as they are sent 
from the IDEXX Reference Laboratories or from your in-house analyzers. 

• See the complete history of a patient’s known IDEXX test results. 

• Compare results from IDEXX Reference Laboratories and IDEXX VetLab* Station tests side by side. 
(To do so, you must activate VetConnect PLUS on IDEXX VetLab Station.) 

• Graph and view trends for IDEXX test results with the click of a button. 
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Data Storage in VetConnect PLUS 
VetConnect PLUS uses patient and test data stored on secure Vet Connect PLUS servers (that is, in “the 
cloud”). If you choose to activate VetConnect PLUS, IDEXX will ask permission to upload a copy of 
historical data from IDEXX Reference Laboratories from your VetConnect account and/or IDEXX VetLab 
Station. IDEXX will not upload this information without your consent. No information is uploaded from 
Cornerstone; Cornerstone performance is not affected. 

Your data in VetConnect PLUS is secure: 

• Sensitive data is not stored in VetConnect PLUS. VetConnect PLUS stores and displays only the 
following: 

• Patient demographics (name, ID, age, sex, species, breed) 

• Client names and IDs 

• Patient test results and the source of the results (IDEXX Reference Laboratories, ProCyte Dx*, 
Hematology Analyzer, SNAP* tests, etc.) 

• VetConnect PLUS does not store or display financial information, phone numbers, addresses, or 
any personal information from your practice, staff, or clients. 

Setup 

Prerequisites 
To activate VetConnect PLUS, your practice must have: 

• Internet access at the workstation where you want to view VetConnect PLUS.  

• Windows®Internet Explorer® 7 or later must be installed on each Cornerstone workstation. It does 
not have to be the default Internet browser. 

• If you want to view in-house results, you must have IDEXX SmartLink* technology to provide 
bidirectional flow between Cornerstone and your IDEXX VetLab Station. In addition, IDEXX 
SmartService* Solutions must be set up for the IDEXX VetLab Station. Call your IDEXX Connectivity 
Consultant at 1-877-256-8457 to order IDEXX SmartLink for your IDEXX VetLab Station if your 
practice does not already have it. 

• If you want to view IDEXX Reference Laboratories results, you must have IDEXX SmartLink* 
technology to provide bidirectional flow between Cornerstone and the IDEXX Reference 
Laboratories. Call your IDEXX Connectivity Consultant at 1-877-256-8457 to order IDEXX SmartLink 
if your practice does not already have it. 

• A VetConnect account with administrator user name and password. Call VetConnect PLUS Client 
Services at 1-888-433-9987 to request an account if your practice does not already have one. 

Activating VetConnect PLUS 
You can activate VetConnect PLUS immediately following installation of Cornerstone 8.3 software or 
anytime after that. After you activate VetConnect PLUS from within Cornerstone, activate VetConnect 
PLUS from your IDEXX VetLab Station (if applicable). 
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To activate VetConnect PLUS: 

1. From the Cornerstone Practice Information window (Lists> Practice), select your practice name, 
and then click Update. This must be your primary practice if you are a Multi-Location Single 
Database user. 

2. From the Account information for drop-down list, select VetConnect PLUS. 

3. If you are a new IDEXX Reference Laboratories user, select the VetConnect option, enter your 
practice’s VetConnect administrator user name and password, and then click Submit to Activate 
VetConnect PLUS. 
OR 
If you are an existing IDEXX Reference Laboratories user, the VCAgent option should be selected 
and your VetConnect user name and password should be completed. Click Submit to Activate 
VetConnect PLUS. 

4. Read the agreement, and then click Accept.  
A message states that IDEXX Reference Laboratories historical data will be uploaded.  

5. Click Next.  

6. IDEXX VetLab Station only: A message giving you the option to print instructions on uploading data 
displays. Click Yes to open the printable message or No to continue.  

7. Click Finish. 

8. A message states that activation is complete and that data upload will continue. Close the message 
window.  

The upload of IDEXX Reference Laboratories historical data that began during activation will continue, 
with the most recent results uploaded first. Upload can take up to 24 hours, depending on the number of 
results being uploaded. You can continue to use Cornerstone software during the upload; Cornerstone 
performance will not be affected.  

To upload data from your IDEXX VetLab Station: 

1. On the IDEXX VetLab Station, tap Settings, and then select the VetConnect PLUS tab. 

2. Tap Activate VetConnect PLUS. 

3. Accept the VetConnect PLUS user agreement.  

4. Enter your VetConnect user name and password.  

5. Tap Next. A confirmation message is displayed. Close the message.  

Data is uploaded in reverse order, starting with your most recent results. You can continue to use 
the IDEXX VetLab Station during the upload.  

Disabling Access to VetConnect PLUS 
If you prefer to use the standard Cornerstone 8.3 workflow for viewing results, you do not need to 
deactivate VetConnect PLUS. All your test results are always available in standard Cornerstone 8.3 
windows. However, if you want to disable access to VetConnect PLUS, you can do so in Cornerstone.  

To disable access to VetConnect PLUS: 

1. From the Cornerstone Practice Information window (Lists> Practice), select your practice name, 
and then click Update. 

2. From the Account information for drop-down list, select VetConnect PLUS. 

3. Select Disable VetConnect PLUS online services, and then click OK.  
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Use 
You can open a patient’s IDEXX Lab Report in Cornerstone and then select the VetConnect PLUS tab in 
the Detailed Lab Results Set window. 

To use VetConnect PLUS from the IDEXX Lab Report: 

1. In the Cornerstone software, open the patient record, and then use your preferred method to open 

an IDEXX Lab Report  that contains the test results you want to see (for example, double-click an 
IDEXX Lab Report on the Summary tab in the Patient Clipboard). 

The Detailed Lab Result Set window opens. 

2. Select the VetConnect PLUS tab. 

See “Understanding the VetConnect PLUS Tab” below for more information about using VetConnect 
PLUS features. 

3. When finished, close the results window.  

Understanding the VetConnect PLUS Tab  

Results in VetConnect PLUS are organized by date 

VetConnect PLUS displays the selected result in its main window. All other results in the patient’s history 
are also available, organized by date. Click a date tab to open the results. 

 

Results for the same analyte are displayed side by side 

VetConnect PLUS automatically displays both the selected result and other results for the same analyte 
that it found in patient history so you can easily compare them. 

In the example below, hematocrit results 11/13/11, are currently selected. VetConnect PLUS also found 
hematocrit results for 5/8/11 and 1/17/11.  
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Click Trending to graph selected analytes 

Select one or more analytes in the left column and then click  to display graphs on the right. The 
gray rectangle behind the graph indicates the reference interval. 

 

Tips: 

•  You can click Trending before or after you select the analyte names.  

• Click  to open the trending graph in its own window. 

Toolbar buttons 

The following buttons are at the top of the VetConnect PLUS tab: 

Patient Tools  

 

Displays patient information and indicates the patient’s species, including: 

• Feline 

• Canine 

• Equine 

• Exotics and other species 

 
Displays all diagnostic results for the current patient. A green plus indicates 
there are possible matches to the current patient record that should be 
reviewed. 

Result Tools  

 
Send the open result by email 

 
Print the open result 

 
Share a result with IDEXX Pet Health Network* Pro 

 Graph results for selected analytes 
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Send a client-friendly report for a canine or feline patient.  

These reports have been designed to communicate information about the 
patient in a format that clients will find clear and engaging. Available reports 
include the Preventative Care Summary (feline or canine) and SNAP* 4Dx* 
Plus Summary (canine only).  

 
View the VetConnect PLUS communications log, which shows details of 
diagnostic lab results and client-friendly reports that have been emailed, 
printed out, or shared through Pet Health Network Pro for the patient. The 
log includes a record of any comments that were sent with results or 
summaries. 

Note: The information in the VetConnect PLUS communication log is not 
viewable elsewhere in Cornerstone. If you want to have a copy of a 
communication in the Cornerstone patient history, print it as a PDF and 
attach it to a medical note. 

 

Most buttons are toggles 

If clicking a button opens a dialog box, window, or menu, click the same button to close it. 

Additional VetConnect PLUS Features 
VetConnect PLUS is updated independently of Cornerstone. From time to time, you may see new 
features in VetConnect PLUS even though you have not upgraded your Cornerstone software. To learn 
about the latest VetConnect PLUS enhancements and new features, periodically do the following: 

1. Open any lab result on the VetConnect PLUS Lab Results tab of the Detailed Lab Results window. 

2. Scroll to the bottom of the results, and click Customer Support. 

3. In the Getting Started area, click the tutorials for getting started link.
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Note: Linking Patient Sex, Species, and Breed Values—In Cornerstone 8.3, an update to the connection 
between IDEXX Cornerstone* Practice Management System and IDEXX VetLab* Station requires linking 
some patient sex and species values in a one-time setup screen. Cornerstone will attempt to 
automatically link values, but you may be prompted to link the values when you log in to the 8.3 
software. 

For instructions, see “Linking Cornerstone Values with Laboratory Values” on page 44.  

Improved Communication with IDEXX VetLab Station 

IDEXX SmartLink* technology in Cornerstone 8.3 software offers these enhancements (excluding 
module): 

• You no longer need to make sure the communication program is running on a specific workstation. 
The IDEXX Application Service automatically handles all communications and must be running on 
the server. 

• Cornerstone 8.3 software automatically detects all IDEXX VetLab Station computers on the practice 
network.  

• Improved handling of work requests for practices with more than one IDEXX VetLab Station. By 
default, all test requests are sent to all IDEXX VetLab Station computers on the network. However, 
you can specify default computers to be used for specific workstations and practice locations. When 
ordering tests, staff can always override these defaults and choose from the entire list of IDEXX 
VetLab Station computers. 

• When patients are checked in through the Cornerstone Census List, the patient information is 
automatically displayed on the Census List of the IDEXX VetLab Station computers associated with 
the check-in practice or the check-in workstation.  

Setup 
To specify default IDEXX VetLab Station computers for a practice and/or workstation: 

1. In the Practice and Workstation Defaults navigation pane (Controls > Defaults > Practice and 
Workstation), select IDEXX VetLab Settings. 
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2. Multi-Location Single Database only: To specify a default IDEXX VetLab Station for a practice 
location, select the practice name from the Practice drop-down list, and then select the IDEXX 
VetLab Station from the VetLab Station box. 

3. To specify a default IDEXX VetLab Station for a workstation, select the workstation name 
(workstation names are displayed on each IDEXX VetLab Station) from the Workstation drop-down 
list, and then select the IDEXX VetLab Station from the VetLab Station box. 

Note: If practice and workstation settings conflict, the workstation settings take precedence. 

4. Click Apply. 

5. Repeat steps 2–4, as needed, for other practice locations and workstations. 

6. When finished, click OK. 

Use 
If default IDEXX VetLab Station computers have been specified, a staff member requesting a test can 
override the defaults and select from the entire list of IDEXX VetLab Station computers. 

To select an IDEXX VetLab Station when requesting a test: 

1. Start the laboratory request using your preferred method. For example, click the Lab Requests and 

Results button  on the toolbar. Then, on the Lab Requests and Results window, click New. 

2. On the New Lab Request window, select INCLINIC. 

If a single IDEXX VetLab Station is available, the window displays its name. If more than one IDEXX 
VetLab Station is available, the name is replaced with “Multiple” or “All.” 

 

3. Click the edit/view link. A list of all available IDEXX VetLab Station computers is displayed. 
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4. Select one or more IDEXX VetLab Station computers (or select the Use all check box), and then 
click OK.  

5. Complete the order as usual. 

After the test has been run on one IDEXX VetLab Station, the request is removed from all of the 
others to which it was sent.
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Overview 
In Cornerstone* 8.3 Practice Management Software (excluding the Mobile Computing module), the 
Antech Diagnostics® laboratory module has been updated to enable online test ordering and automatic 
result download. The updated module offers the following enhancements: 

• The Antech Diagnostics profile list (a list of commonly used Antech order codes) is updated 
automatically by Antech Diagnostics, as needed. The IDEXX Cornerstone* Practice Management 
System software alerts you when Antech updates its list prices.  

• You can specify an automatic markup percentage for Antech Diagnostic profiles, just as you can for 
IDEXX profiles. 

• When you order an Antech Diagnostic profile, Cornerstone software checks the order for accuracy 
and then generates a bar-coded Antech Diagnostic order form appropriate for the profile type. Print 
the form and include it with your specimens. 

• When your order is complete, Cornerstone sends the profile request to the laboratory electronically.  

• Results are automatically downloaded from the laboratory approximately once per hour. 

Setup 

Activating the Antech Diagnostics Laboratory Module 
Contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386 for information about 
purchasing and activating the updated Antech Diagnostics laboratory module. Please note that the 
activation process includes reinstalling the Cornerstone software. After the updated module has been 
activated, follow the procedures below to take advantage of the latest enhancements. 

You must also perform a one-time setup of your Antech login information in the Practice Information 
window. 

To access Login/Password Management settings: 

1. On the menu bar, select Lists > Practice. The Practice List dialog box appears. 

2. With your practice name selected, click Update (or double-click the practice). The Practice 
Information dialog box appears. 

3. On the Practice Information window, in the Login/Password Management area, select Antech 
Reference Lab Results from the Account information for drop-down list. 

4. If you already have Antech set up in Cornerstone, click Apply Primary Practice Settings. The 
account information boxes are automatically completed. 

5. If you don’t have existing Antech account information, enter the information provided when you set 
up your account. 

6. Click Test. Then, when the Login Settings Passed message appears, click OK. 
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Linking Patient Sex, Species, and Breed Values 
Patient sex and species values for all laboratories in Cornerstone, including Antech Diagnostics, must be 
linked to Cornerstone values. Linking breed values is optional, but it is recommended if you want your 
patient’s breed listed on your Antech result report. For instructions, see “Linking Cornerstone Values with 
Laboratory Values” on page 50. 

Setting Pricing Options 
Set or change the default pricing options on the Antech Diagnostics Lab Information window. 

You can also manually set profile prices or change the markup percentage. Set or change these values 
on the Antech Diagnostics Lab Item Price Update window. 

To set default Antech pricing options: 

1. From the Lab List (Activities > Lab Work > Laboratories), select the Antech Diagnostics 
laboratory, and then click Update. 

 

2. Set pricing options in the Antech online area, in the lower right corner of the window, and then click 
OK. 

If you select Automatically update prices, your practice prices are recalculated automatically, 
based on the markup percentage you specified, whenever new prices are downloaded from Antech 
Diagnostics. The prices will be updated in Cornerstone software during the next End of Day 
processing. 

To set Antech prices manually: 

1. On the Activities menu, select Lab Work > Update Antech Lab Item Prices. 

The Antech Diagnostics Lab Item Price Update window displays your current price, the price 
charged by Antech, and the new calculated price. 

2. Manually update individual prices, or change the markup percentage to calculate new prices. 

3. When finished, click OK. 
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Use  

Viewing and Updating Profiles 

To view or update Antech Diagnostics profiles:  

1. From the Profile List (Activities > Lab Work > Profiles), select the Antech Diagnostics laboratory 
from the Lab drop-down list.  

2. To view or update a profile, double-click the profile name, or select it and then click Update.  

 

3. Modify details on the Profile Information window, as needed.  

 

Note: When the This is a Cytology/Histology profile check box is selected, the Cornerstone 
software prompts for additional information whenever you order a cytology or a histology profile. Do 
not clear this check box for any cytology or histology profile.  

4. Click OK. 

Ordering a Profile 
When you order an Antech Diagnostics profile, Cornerstone 8.3 software generates an Antech-specific 
form. However, the form for cytology/histology profiles is different from the standard Antech Diagnostics 
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form. For that reason, you cannot combine cytology/histology profiles with other profiles on the same 
form.  

To order an Antech Diagnostics profile: 

1. Start a new laboratory request using your preferred method.  

2. On the New Lab Request window, select the Antech Diagnostics laboratory. 

3. Under Profiles/tests, enter the item ID for the profile or press F2 to search for and select the profile. 

4. Click OK on the New Lab Request window.  

5. If you ordered cytology or a histology profile, provide the additional information requested in the 
Information for Antech Cytology/Histology Lab Test window, and then click OK. 

 

Cornerstone validates the request and submits the request to the laboratory electronically.  

The Print Lab Request dialog box opens. 

6. If your request is complete, select print options and click Print. 

7. If this is a cytology/histology order, mark the specimen site (if applicable) on the dorsal/ventral 
images at the bottom of the printed form.  
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Antech Diagnostics cytology/histology order form 

8. Include the printed form with the specimens you send to the laboratory. 

Updating a Pending Test Request 
You can update a pending Antech Diagnostics request until specimens have been received at the 
laboratory. After specimens have been received, the Pending Request window displays a notification 
message stating that test updates are no longer allowed. If you have questions or concerns about the 
test, contact the laboratory directly. 
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Miscellaneous Laboratory Enhancements 

Version 8.3 of the IDEXX Cornerstone* Practice Management System offers many additional 
improvements to laboratory requests and results, both for in-house and reference laboratory orders. 

Specifying Staff IDs for Laboratory Requests 
You can now specify a default staff ID for laboratory requests, including a “No default staff” option. Use 
the new Labs panel in the Practice and Workstation Defaults window. 

To specify a default staff ID for laboratory requests: 

1. In Practice and Workstation Defaults (Controls > Defaults > Practice and Workstation), select 
Labs. 

 

2. For requests associated with special actions, select the Use billing staff on a new lab request 
check box to designate that the billing staff on the Patient Visit List or the invoice should be used as 
the default staff ID on the request. 

Currently, if this option is not selected, then the default staff ID for special action requests is the ID of 
the last staff member who performed a lab request on the workstation. 

3. For lab requests not associated with special actions, select from the following options: 

• No default staff—The person creating a request will need to select a staff ID for each request. 

• Last staff used on workstation—The default staff ID will be the ID of the last staff member who 
created a request on the workstation. 

• Specific staff—Type a default staff ID, or press F2 to search for and select the ID.  

4. Click OK. 

Result Download and Result Matching 
• In Cornerstone 8.3 software, the server automatically handles all communications. It is no longer 

necessary to make sure the communication program is running. 

• As long as the Cornerstone database and IDEXX Application Service are running, laboratory results 
will be received even when the Cornerstone 8.3 application itself has been shut down. 

• Laboratory results are displayed in bolder text in medical notes and reports, making them easier to 
read.  
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• The Diagnostics tab in the Daily Planner window allows you to perform callbacks from the IDEXX 
Lab Report entries. You can create and update a single callback for all results on the IDEXX Lab 
Report, rather than updating the same callback multiple times.  

• When ordering tests from the Patient Visit List or invoice, the laboratory order form is not printed until 
the window is closed. The software now generates a single combined form containing all ordered 
tests (when possible—larger reports may not be combined); you no longer have to update a call 
back for each individual test. 

• Results received from IDEXX Reference Laboratories are matched to requests based on the top-
level profile code, not on the component test codes. This means that if a component code within a 
profile has changed, the results for that component are no longer returned as “not requested,” as 
long as the top-level profile code remains the same.  

• Results returned from IDEXX Reference Laboratories and from IDEXX VetLab Station can be 
matched on the patient ID if the patient ID was submitted with the request.  

• The IDEXX Message Center lists all recently returned results from IDEXX Reference Laboratories and 
the IDEXX VetLab* Station. Click the IDEXX Message Center  button on the toolbar to open the 
window, and then click the Lab Results tab. The button appears in red and black when new lab 
results have been added since the last time you looked at the message center. 

 

IDEXX Lab Report 
• When an IDEXX Lab Report is available, a single line for the report is displayed on the Summary tab 

in the Patient Clipboard window and in the Daily Planner window. There are no longer separate lines 
related to each test template in the request. However, the Text and Lab tabs continue to display 
separate lines for each template.  

• When you double-click an IDEXX Lab Report in the Patient Summary or Daily Planner, the results 
open in the Detailed Lab Results Set window, which contains three tabs. Each tab provides results 
in a different format: the IDEXX Lab Report; detailed lab results; and VetConnect PLUS. See the 
“VetConnect* PLUS” section starting on page 34 for more information about the VetConnect PLUS 
tab. 
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Linking Cornerstone Values with Laboratory Values 
When you log on to Cornerstone 8.3 software, Cornerstone prompts you to link the Cornerstone values 
for patient sex and species with the sex and species values for IDEXX VetLab* Station. This will save you 
time when ordering tests—if you do not link the sex and species values, you will be prompted to link 
values for the specific patient when you order a test. 

You must also link patient sex and species values for each reference laboratory. For reference 
laboratories, you have the option to link breed values as well. 

 

To link Cornerstone values to IDEXX VetLab Station and reference laboratory data: 

1. On the Activities menu, select Lab Work > Setup Lab Links > Link Sexes.  

2. From the Lab drop-down list, select IDEXX VetLab Station. 

Cornerstone values are displayed in the left column, and IDEXX VetLab Station values are displayed 
in the right column. 

 

3. For each row, select a value in the right column that corresponds to the Cornerstone value in the left 
column. 

4. When finished, click OK.  

Cornerstone 8.3 What’s New                  50 



Miscellaneous Laboratory Enhancements 

 

5. Repeat steps 1–4 for each reference laboratory in the Lab drop-down list.  

6. When you have finished linking values for sexes for all the laboratories, on the Activities menu, 
select Lab Work > Setup Lab Links > Link Species.  

7. Follow the general steps above to link species values to IDEXX VetLab Station and reference 
laboratory data. 

(Optional) To link Cornerstone breed values to reference laboratory breed values: 

1. On the Activities menu, select Lab Work > Setup Lab Links > Link Breeds.  

2. From the Lab drop-down list, select the reference laboratory. 

3. From the Species drop-down list, select the species.  

4. For each row, select a breed value in the right column that corresponds to the Cornerstone value. 

5. When finished, click OK.  

Note: Repeat the steps above for each additional reference laboratory you want to link. 
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Imaging Overview 

Cornerstone* Imaging 

DICOM Imaging and Diagnostic Imaging 

IDEXX-PACS* Imaging Software (formerly IDEXX Digital Radiography) 

Modality Worklist Integration 
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Imaging Overview 

There are three levels of imaging features available in the IDEXX Cornerstone* Practice Management 
System: 

• Cornerstone Imaging—With only the Cornerstone software, you can import, view, and send by email 
basic types of images and attach them to the patient’s medical record.  

• DICOM Imaging—With the addition of DICOM Imaging, you gain the ability to use the DICOM 
standard to import and send images, as well as a number of advanced imaging features. 
(Diagnostic Imaging, available with previous versions of Cornerstone, includes a similar set of 
features.) 

• IDEXX–PACS—IDEXX-PACS* Imaging software adds the ability to capture radiographs, along with 
features to make the image capture process more efficient. Of course, you have all the Cornerstone 
Imaging and DICOM Imaging features as well. (In previous versions of Cornerstone, this imaging 
level was called IDEXX Digital Radiography.)  

You can add image request and results functionality that helps you more fully integrate your practice’s 
imaging devices with Cornerstone: 

• IDEXX SmartLink* Technology (used with IDEXX-PACS software)—SmartLink integration lets you 
request radiographs quickly and easily from anywhere in your practice, reducing double data entry 
and reducing missed charges. 

• Modality Worklist Integration (used with DICOM Imaging or Diagnostic Imaging)—Modality Worklist 
integration lets you request radiographs from non-IDEXX imaging systems, such as ultrasound and 
CT devices. As with SmartLink, Modality Worklist integration also helps to reduce missed charges 
and add completed images to the medical record. However, the exact level of billing and medical 
record integration depends on the capabilities of the device. 

The table on the next page offers a more detailed view of the features available in each level of imaging.  
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 Cornerstone 
Imaging 

DICOM 
Imaging  
 
 

IDEXX-PACS 
 

IDEXX-PACS 
with  
IDEXX 
SmartLink 
 

DICOM 
Imaging  
with  
Modality 
Worklist 
Integration  

Image Explorer X X X X X 
Image  Viewer X X X X X 
Create patient CD X X X X X 
Send image via Email X X X X X 
Add basic annotations X X X X X 
Import basic image types  
(JPEG, BMP, TIFF) X X X X X 

Scan images X X X X X 
Import videos X X X X X 
Telemedicine X X X X X 
DICOM: Send,  receive, 
import, query/retrieve and 
auto-route 

 X X X X 

Use advanced image 
enhancement tools   X X  

Capture stills from videos   X X  
Multi-image  layout by 
modality   X X  

Apply preset window/level 
adjustments    X X  

Capture radiographs   X X   X†  
Create image request    X X 
Automatically capture 
charges for requested images    X X 

View request status    X     X‡ 
Prompt you to bill for  
non-requested images    X X 

View completed image    X     X‡ 
Save image to medical record    X     X‡ 

† You can capture images with a non-IDEXX imaging system as part of an integrated work flow with Cornerstone.  

‡ Use of these features depends on the capabilities of the device and its software. 
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Use 

Enhanced Crop Tool 

More easily adjust the crop rectangle: 

• To adjust the border, click and drag an edge of the rectangle.  

• To rotate the crop area, click and drag one of the corners. 

• To move the crop area, click and drag anywhere within the border. 

 

An image with a slightly rotated crop outline 

Imaging Connections Status Bar 

The IDEXX Cornerstone* Practice Management Software on your computer is connected to other 
computers inside and outside of your practice. The status bar displays the current state of the 
connections that are related to imaging. 

  

To view overall connection status:  

The Connections status bar is displayed in the lower left of the Image Explorer window. It is also 
displayed in the Imaging Dashboard (Diagnostic and Digital Radiography only). The color of the icon 
indicates the status of all of the imaging connections for the computer. 

Red—One or more of the connections that have been set up is not running. 

Yellow—One or more of the connections requires attention. 

Green—All of the connections that have been set up are running. 
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To view status for each connection:  

 Click Connections in the lower left of the Image Explorer window (or Imaging Dashboard, if you 
have an IDEXX Digital Imaging system). The status bar opens.  

Connection status details: 

A colored status icon is displayed for each connection:  

• Red—Not running 

• Yellow—Requires attention (for example, a yellow status for the DICOM® connection indicates a 
problem sending or receiving images) 

• Green—Running 

• Gray—Not set up on this computer 

Note: If you move your mouse over an icon, text with status details appears. 

The connections are:  

• DICOM—This icon appears only on the computer that is the server for your Cornerstone 
network. It shows whether IDEXX DICOM services, which sends and receives DICOM images, is 
running. It also shows whether any failure has occurred in sending or receiving images. You can 
use the links next to the icon to start or stop DICOM services or to view the DICOM queue. 

 Note: This icon is activated only if you have DICOM Imaging or Diagnostic Imaging.  

• Database—If you have a server/workstation set up, each computer is connected to the database 
that resides on the server. This icon shows the status of that connection. 

• MWL—This icon does not apply for the current version of Cornerstone. 

• SmartService—This status icon appears only on the Cornerstone server. It shows the status of 
your connection to IDEXX SmartService* technology, which allows you to upgrade your software 
over the Internet. 

• Telemedicine—If you have set up a connection to one or more telemedicine providers, this icon 
shows the status of those connections. 

• SmartLink—If IDEXX SmartLink* technology is set up for your IDEXX Digital Imaging system, this 
icon shows the status of the connection between the IDEXX-PACS* Imaging Software and the 
rest of the Cornerstone software. 
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Note: If you have the DICOM Imaging or Diagnostic Imaging modules, you have the feature described in this 
section as well as the features described in the “Cornerstone* Imaging” section that starts on page 55. 

Use 

Improved DICOM® Queue 

The DICOM® queue shows the progress of images that are being sent or received using the DICOM 
standard. The queue has been reformatted for better readability.  

When you send images via DICOM, the DICOM queue displays detailed information for each image. 
Also, the queue shows the status of DICOM services and gives you the ability to restart DICOM services 
as needed. 

 

To use the DICOM queue: 

 On the menu bar, select Activities> Imaging> DICOM Queue. The DICOM Queue window 
appears. 

To view the status of the DICOM connection and restart if needed: 

A status icon appears in the lower left of the DICOM Queue window. The icon tells you about the status 
of the DICOM connection through color and text: 

• Green (DICOM started)—IDEXX DICOM services are running and the queue does not contain any 
sent or received images with a status of Failed. 

• Yellow—Check the queue for information about sent or received images that have failed. You may 
see this status when DICOM is started or when it’s stopped. 

• Red (DICOM stopped)—The DICOM server is not running. Click Restart DICOM Services to restart 
DICOM services. 
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IDEXX-PACS* Imaging Software 

Note: If you have an IDEXX Digital Imaging system, you have IDEXX-PACS* Imaging Software within 
Cornerstone, which includes the features described in this section as well as the features described in the 
“Cornerstone* Imaging” (see page 55) and “DICOM Imaging or Diagnostic Imaging” (see page 57) sections. 

Use 

Changes to the Image Capture Window 

The Image Capture window has been redesigned in version 8.3 of the IDEXX Cornerstone Practice 
Management System. In addition to new features like Image Coach* tools and the technique prompt 
(discussed below), the reprocess feature has moved. 

If you have an IDEXX-DR* 1417, IDEXX I-Vision DR*, IDEXX EquiView* system, or an IDEXX-CR* 1417 
Digital Imaging System with ClearCapture DX* Image Processing technology, you have the reprocess 
feature. In previous versions of Cornerstone, the feature was located on the right side of the Image Capture 

window. In version 8.3, you access the feature by clicking the Reprocess button  at the top of the 
window. 

 

The Image Capture window 

Image Coach* Tools 

If you have an IDEXX Digital Imaging system, several new features on the Image Capture window can 
help you: 

• Train new technicians. 

• Encourage standard radiography practices for all staff members. 

• Troubleshoot problems related to under or overexposed images. 

Real-Time Positioning Aid 

Before you capture a radiograph, you can see a photograph that shows how the patient should be 
positioned. Hints for proper positioning also appear. 
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To display the positioning aid: 

 On the right side of the Image Capture window, click Position . A photograph appears, 

showing the proper patient positioning. Next to the photo is a text description of the positioning, 
along with recommended beam center, measurement point, and other variables, as well as other 
hints for obtaining the best quality radiograph of that view. 

 
Positioning photograph and text 

Reference Radiographs 

The Image Coach contains example radiographs for frequently captured exam types.  

You can see the reference radiograph before you capture, or view it side by side with your radiograph 
after capture.  

To display a reference radiograph before you capture: 

 On the right side of the Image Capture window, click Reference . An image 
appears, showing an example of how a radiograph should look for the selected view. This 
radiograph is provided to assist in taking the radiograph correctly, not as an example of any 
particular pathology. 
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Reference radiograph 

To compare a radiograph to the reference radiograph: 

 At the top of the Image Capture window, click Compare to Reference . Your radiograph 
appears on the left and the reference radiograph appears on the right. 

 

Comparing a radiograph to a reference example 

Technique Prompt 

Before you take each radiograph, the capture screen can display the recommended technique (kVp and 
mAs) that you should use for that exam type. These technique settings are displayed on the capture 
screen in large type that’s easy to view from a distance. To see recommended technique, you need to 
select either the weight of the patient or the thickness of the body part. 

Note: If you're using an IDEXX I-Vision DR* or IDEXX-DR* 1417 system, your technique chart is set up 
by weight rather than thickness. If you want to change to a thickness-based chart, contact IDEXX Digital 
Imaging Customer Support at 1-877-433-9948.  
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To view the suggested technique for a radiograph you are about to take: 

 On the right side of the Image Capture window, select the weight of the patient or the thickness 
of the body part to be radiographed. The kVp and mAs for that view appear in large numbers 
above the thickness selection area. 

 
The technique prompt and the thickness (or weight) selection area 

 

To set up technique prompt values: 

1. On the menu bar, select Controls> Defaults> Imaging. The System Settings window appears. 

2. On the left, click Exam Trees and then click Capture technique chart. The header row for a table of 
technique chart values appears. 

IMPORTANT: Do not change any other settings related to the exam tree without consulting IDEXX 
Digital Imaging Customer Support. 

  

Capture technique chart  

3. In the Unit of Measurement drop-down menu, select the unit you use to measure patient weight or 
thickness of the body part to be radiographed. 

4. Click Add. A blank row appears in the table. 

5. In the Measurement Range text box, type a thickness range (in centimeters). 

6. In the kVp and mAs text boxes for each anatomical region, type the values from your technique 
chart. 

Note: The software will extrapolate from these three general region settings in order to display 
technique values for all exam types. 
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7. To enter values for another anatomical thickness, click the Add button and repeat steps 5 and 6. 

8. To delete a row, click in the row to select it and then click Delete. 

9. Click Save to save and close the System Settings window. 

10. Click Close in the upper right of the Cornerstone window to close the software and then open the 
software again for the changes to be applied. 

Exposure Index  

After you capture a radiograph, a scale on the Image Capture window displays the level of x-ray 
exposure. This exposure index shows whether the proper amount of x-rays to produce a diagnostic 
image reached the detector or screen or if the image was improperly exposed. 

 
The exposure index is primarily meant to provide troubleshooting information for nondiagnostic 
radiographs. For example, if you have an all-white or all-black image, a high- or low-exposure index 
reading is a valuable piece of information to have when discussing solutions with IDEXX Digital Imaging 
Customer Support. 

More Powerful IDEXX I-Vision Mobile* Application 
The IDEXX I-Vision Mobile* application offers a redesigned viewer with more image manipulation 
features, larger images, and improved zoom. The redesigned viewer is shown below. 

 

 

Mobile viewer, upper toolbar expanded 

The redesigned IDEXX I-Vision Mobile viewer includes an upper toolbar and a lower toolbar. 

The upper toolbar contains three sections: 

• Top: Image thumbnails and navigation arrows 

• Center: Patient, client, and capture information 

• Bottom: Details about the currently displayed image 

The lower toolbar contains a help button, image manipulation tools, and tools for image sharing.  
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To open the upper toolbar:  

➣ Drag the handle down. 

To navigate through the images, do any of the following:  

• Tap the thumbnails. 

• Tap the left or right arrows. 

• Swipe left or right. 

To use any tool:  

• Tap the tool to open it. 

• If a palette is displayed, tap a selection in the palette, and use any controls that become available. 

• Tap the tool again to close it. 

Important: While a tool is open, the application is in “tool mode.” You can perform only actions related 
to that tool. You cannot use other tools or change images until you close the current tool.  

Enhanced Image Viewer Tools 
In the updated I-Vision Mobile application, you can now: 

• Add text, lines, arrows, and shapes to an image. 

• Pan an image left or right. 

• Flip an image horizontally or vertically. 

• Rotate an image to any degree. 

• Fit the image to the screen width. 

To perform any of these functions, use the tools in the menu bar at the bottom of the screen or use the 
corresponding touch-screen gestures. The tables below will help you get started.  

IDEXX I-Vision Mobile Tools 

Help 
 

Displays a text overlay that identifies each feature of the 
viewer. 

Annotate 
 

Opens a palette of annotation tools. See “New Annotation 
Tools” for more information.  
 

Cornerstone 8.3 What’s New                  63 



IDEXX-PACS* Imaging Software 

 

Zoom 
 

Displays zoom options. See “Improved Zoom” for more 
information.  

Window/level 
 

Opens window/level controls to change contrast and 
brightness. 

Invert colors 
 

Reverses colors in an image. 

Flip 
horizontally or 
vertically, or 
rotate 

 
Opens a palette of tools to flip images left/right and 
up/down, or rotate clockwise/counterclockwise. 

Restore 
 

Restores image to its original state. 

Share 
 

Displays a palette of tools for image sharing (email, 
DICOM®, telemedicine). 
 

Fit to screen 
 

Fits image to the width of the screen. 

 
IDEXX I-Vision Mobile gestures 

Zoom 
 

Pinch fingers to zoom out. Spread fingers to zoom in. 

Pan 
 

Drag left/right with one finger. 

Window/level 
 

Open window/level tool, then drag left/right to control 
contrast. Drag up/down to control brightness. 

Flip 
horizontally or 
vertically 

 
Drag left/right with two fingers to flip image horizontally.  
Drag up/down to flip image vertically. 
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Rotate 
 

Drag forefinger in a circle around thumb to rotate image. 
 

Fit to screen 
 

Double-tap to enlarge image to fill width of screen. 

 

New Annotation Tools 

To use the annotation tools: 

1. In the lower toolbar, tap the annotation tool to display the annotation palette. 

2. Tap the tool you want.  

3. Drag your finger on the image to apply the annotation. For text annotations, tap in the text box 
displayed, and then use the on-screen keyboard to type your text.  

4. Tap size and color formatting options.  

Tip: If you make a mistake and want to start over, tap the garbage can icon to delete the annotation.  

5. When ready, tap the annotation tool in the main toolbar to close the tool. Your annotations remain on 
the image until you close the mobile application.  

To change or delete an annotation: 

1. Tap the annotation on the image to select it. (You must tap exactly on the line or text.) The 
associated formatting or text palette opens. 

2. To change the annotation, update the size, color, or text as needed. To delete the annotation, tap 
the garbage can icon. 

3. When finished, tap the annotation tool to close the tool. 

Larger Images 

A radiographic image now occupies the entire IDEXX I-Vision Mobile screen, giving you a better view. 

Improved Zoom  

Zoom tools have been improved to give you more control. 

Tap the zoom tool and then change the image size any of these ways: 

• Tap a percentage. 

• Tap +/– to adjust image size in small increments. The actual percentage applied is shown in the 
upper tab of the zoom options. 

• Drag the upper tab left or right. 

• Tap Fit to fit image to the width of the screen. 

As always, you can use the pinch/spread gesture on the image to zoom out and in. 

Additional improvements: 

• When you zoom, only the image changes size. The browser frame and buttons remain the same 
size. 
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• After a zoom, the image retains its new size until you change it.  

• You can now apply window/level adjustments to a resized image. 

Scanner Software Upgrade for the IDEXX I-Vision CR* System 
A new version of the scanner software for the IDEXX I-Vision CR system is available if you are using the 
Windows® 7 operating system. Contact IDEXX Digital Imaging Customer Support at 1-877-433-9948 for 
more information or to upgrade. The following new features are part of this upgrade:  

• Erase button—Erase an imaging cassette with a single click.  

• Skip scanner interface—When capturing radiographs, you no longer need to reselect the view on 
the blue scanner interface window. 
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Overview 
In version 8.2 of the IDEXX Cornerstone* Practice Management System, IDEXX SmartLink* Digital 
Imaging was enhanced to provide a more flexible image request work flow using the Image Request 
special action feature. This made it easier to set up and maintain digital imaging invoice items.  

Cornerstone 8.3 introduces Modality Worklist Integration, which offers a similar request workflow for 
other, non-IDEXX imaging systems. This means that, in addition to requesting and receiving images 
from IDEXX digital radiography systems, you can now create and manage image requests directly from 
Cornerstone for non-IDEXX imaging systems that are compatible with the Modality Worklist functionality 
of the DICOM® standard.  

IDEXX supports modality worklist connections for systems where we have tested and validated the 
connection with the system vendor or manufacturer. We maintain a list of systems that have been 
validated by IDEXX as capable of integrating with Cornerstone. See idexx.com/validatedsystems for the 
list of validated systems. There is a one-time fee for setting up the integration between a validated 
system and Cornerstone. For more information, contact your IDEXX Cornerstone Sales Representative at 
1-800-283-8386. 

As with any integration between Cornerstone and non-IDEXX devices, the level of integration depends 
on the capabilities of that non-IDEXX system. The table on the next page gives a general overview of the 
work flow you will experience at different levels of integration. 
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For all integration levels: 

• The device is DICOM-compliant.  

• The device supports the modality worklist feature of DICOM, either on its own or with additional software. 
 For basic integration: For partial integration: For high-level integration: 
How the system uses 
DICOM. 

The system does not automatically 
send images to Cornerstone. You 
may be able to use DICOM to 
import images manually. 

The device auto-routes images to 
Cornerstone. 

 

The device supports the DICOM 
Modality Performed Procedure Step 
(MPPS) feature. The device can support 
MPPS on its own or with the help of 
additional software.  

Can you send image 
requests from 
Cornerstone to the 
system? 
 

Yes Yes Yes  

Does Cornerstone 
capture charges 
automatically for 
requested images? 
 

Yes Yes Yes 

 

Does Cornerstone 
prompt you about billing 
for images that weren't 
requested? 
 

No No Yes  

How the image is 
displayed and stored 

The image is not displayed in the 
patient history or stored in 
Cornerstone unless you import it 
manually. 

Cornerstone stores a copy of the 
image, and attaches it to the 
medical record. 

The images are part of the medical 
record automatically. The image is 
stored by the imaging system. When 
you view the image, Cornerstone 
launches the imaging system software 
to display the image. 

Seeing request status in 
Cornerstone 

Because the system isn’t fully integrated, Cornerstone is not able to 
display whether or not the image request has been completed. This means 
you’ll need to manually mark requests as completed in Cornerstone after 
you capture the images on the system. 

Completed requests are automatically 
marked as completed 

Note: For information on purchasing the DICOM Imaging or Modality Worklist Integration, contact your IDEXX Cornerstone Sales Representative at 
1-800-283-8386. If you have an IDEXX Digital Imaging system and already have SmartLink Digital Imaging, you do not need to purchase any 
additional modules. 
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Preparing for Integration 
The checklist below will help you gather the information you need to have on hand in order to integrate 
Cornerstone with a validated device. Most of these information requirements apply to all levels of 
integration; those requirements that apply only to certain levels are marked. 

About the validated device:  

 Are DICOM features currently enabled on this device? 

 Do you know how to change DICOM settings on this device? 

 Do you have user documentation for this device, including the DICOM conformance statement? 
Documentation may be printed or online. 

 Do you know the model number of the device and the version number of any additional software 
you use with the device? 

 If you need additional software to support modality worklist features, have you installed that 
software and does it support MPPS? 

 Do you have a customer support agreement for the validated device? 

 For partial integration: Does the validated device automatically send images to Cornerstone as 
it captures them? Or, if the device is not currently sending images automatically, can that 
feature be set up? 

About your computer network: 

 Is the validated device connected to your practice’s computer network?  

 Does the validated device use a Static IP address on your network? If not, can a Static IP 
address be set up for the device? 

 Does the device store images somewhere on the network other than on the device itself? 
Examples might include a PACS system or an external hard drive.  

About your copy of Cornerstone:  

 Do you currently have DICOM Imaging or IDEXX-PACS software (or the previous Diagnostic 
Imaging)? 

 If you have an IDEXX Digital Radiography system, do you currently have SmartLink Digital 
Imaging? 

 Do you currently store images from this device in Cornerstone?  

Work flow questions:  

 Have you reviewed the work flow you will experience with this device and found it acceptable for 
the way your practice works?  

 For basic or partial integration: Is the work flow of manually marking requests as completed 
acceptable for your practice?  

Setup 

New Option to Specify a DICOM Modality When Setting Up an Image Request Special 
Action 

You can set up a special action for an invoice item so that use of the item on the Patient Visit List (PVL) 
or invoice automatically prompts Cornerstone to perform a certain action. With the new DICOM modality 
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selection options in Cornerstone 8.3, you can select a specific modality to be associated with an invoice 
item using the Image Request special action.  

Note: To set up an invoice item to initiate an Image Request special action, image request functionality 
must be activated. 

You can set up the Image Request special action for an item on the Invoice Item Information window’s 
Spec. Actions tab. When you select the Image Request special action, a new Modality selection list is 
available. 

 

You can select or change the modality at the time of use, if necessary. If you select a non-IDEXX 
modality, in most cases you will want to indicate the exam you want by typing notes in the Exam 
Description field. 

These values default into an image request every time the special action is launched. You may also 
leave the Modality and Exam Description fields blank. 

Note: The Shot Selection  option is available only if an IDEXX-installed modality is selected.  
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Use 

Option to Select a Modality When Creating a New Image Request 
The New Image Request dialog box has been enhanced to include a new Modality selection list. 

 
When creating the image request, you must specify a modality, and then do one of the following:  

• If an IDEXX-installed modality is selected, you must either click the Shot Selection  icon and 
select shots for the request or enter an exam description. 
Note: If shots are not selected when the image request is created, then any shots captured during 
the image capture session complete the request. 

• If a non-IDEXX modality is selected, you must enter an exam description.  

Note: The Shot Selection  icon is available only if an IDEXX-installed modality is selected.  

Enhancements to the Image Requests and Results Window 
The Image Requests and Results window is a central location where you can see the status of your 
image requests. In Cornerstone 8.3, this window has been enhanced to provide the following new 
features: 

• New modality filter 

• Modality type column in grid, allowing you to see what modality type was used on a request 

• New request status filters for Started requests and Orphan results (available with high-level 
integration):  

• Started status—An image request that has been picked up by a non-IDEXX imaging unit. 
Indicates that the job has been received by the unit but does not indicate whether any images 
have been captured. 

• Orphan status–An image exam that has been sent back from a non-IDEXX modality with a 
patient ID that does not match a patient ID in Cornerstone.  

Note:  If your modality does not support MPPS, you do not have access to this feature. 
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Resolving Orphan or Not Requested Statuses for a Non-IDEXX Imaging Modality 
Cornerstone 8.3 provides options for updating an imaging request with a status of Orphan or Not 
Requested returned from a non-IDEXX imaging device. This feature is available with high-level 
integration only. 

Orphan Results 

If an image request communication is sent back to Cornerstone and the patient or client information 
does not exist in Cornerstone, the result is an Orphan. 

To resolve an Orphan result from a non-IDEXX imaging modality: 

1. On the Image Requests and Results dialog box, select an Orphan image, and click Update. 

2. Use the following fields/options on the Update Orphan Exam window help you to resolve the Orphan 
exam result in Cornerstone: 

• The Patient Information from Exam area displays information sent along with the Orphan result 
from the non-IDEXX 
imaging system. 

• The number of 
images and capture 
date are provided 
(helpful for billing if 
your practice bills on 
a per-shot basis). 

• If you want to view 
information that can help you to match the image to the correct patient in Cornerstone, click 
Image Details. The DICOM header file information from the non-IDEXX imaging system 
appears. 

• If you need to look at the image to be able to decide whether you want to bill the client, and the 
system used to capture the images either supports MPPS or automatically sends images to 
Cornerstone, click View Image to open the Image Viewer.  

3. If you determine the proper patient ID, enter the ID for the correct patient in the Patient ID text box. 

4. To either bill or not bill for this image, select Do not bill this client or Bill this client.  
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5. If you chose not to bill, continue with step 7. 

6. If you chose to bill, do the following:  

a. Select the invoice item ID that you want to use for billing.  

b. If you need to change the ID, click the Invoice item ID field and press F2. The Invoice Item List 
dialog box appears, and displays a list of all the imaging invoice items. You have several ways 
to narrow down this list:  

• If you want to filter the list by classification, click in the Classification text box and press F2. 
Then select the classification that you use for radiographs, such as Radiography. 

• If you want to filter the list by Item ID, click Item ID in the Search by area and then type the 
ID in the Item ID text box.  

• If you want to search by using words that are part of the description, click Description in the 
Search by area and make sure that the Search for word check box is selected. Then type 
part of the description in the Description text box and the list displays invoice items that 
match. 

c. Select the invoice item you want and click Select. 

d. Select the appropriate revenue center if it does not appear automatically. To see a list, click the 
Revenue Center text box and press F2. 

7. When you are finished, click OK to close the Not Requested Image for… dialog box, and then click 
Close to close the Image Requests and Results window. The image is now listed as Completed (in 
the Patient History area on the Patient Clipboard.) 

Not Requested Results 

If an image is captured for a patient that exists in Cornerstone but the image was not part of an image 
request, the result is Not Requested. This feature is available with high-level integration only. 

To resolve a Not Requested image: 

 

1. On the Image Requests and Results dialog box, select a Not Requested image, and click Update. 
The Not Requested Image for…  dialog box appears. 

2. If you need to look at the image to be able to decide whether you want to bill the client for it, click 
View to open the Image Viewer.  
Note: The number of images and their capture dates are shown on the Not Requested Image for... 
dialog box (helpful for billing if your practice bills on a per-shot basis). 

3. If this image is not assigned to the proper patient, follow “To reassign image to proper patient and 
resolve billing,” below. 
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4. If you do not want to bill for this image, select Do not bill this client, and continue with step 6. 

5. If you want to bill for this image: 

a. Select Bill this client. 

b. Select the invoice item ID that you want to use for billing.  

c. If you need to change the ID, click the Invoice item ID field and press F2. The Invoice Item List 
dialog box appears, and displays a list of all the imaging invoice items from which you can 
choose the appropriate ID. 

6. When you are finished, click OK to close the Not Requested Image for… dialog box, and then click 
Close to close the Image Requests and Results window. The image is now listed as Completed (in 
the Patient History area on the Patient Clipboard.) 

To reassign image to proper patient and resolve billing: 

1. On the Image Requests and Results window, select Do not bill this client and click OK to exit. 

2. On the Patient Clipboard, right-click the image in the Patient History area and select Image 
Explorer. 

3. On the Image Explorer window, select the image and click Reassign. 

4. Reassign the image to the proper patient.  

5. Close the Image Explorer. 

6. View the proper patient on the Patient Clipboard. 

7. Right-click the image in the Patient History area and select Image Requests and Results. On the 
Image Requests and Results window, the image has a status of Not requested. 

8. Follow the procedure above to bill or not bill for the Not requested image. 

Manually Setting Requests to a Status of Completed 
If the imaging device does not support MPPS (basic or partial integration), Cornerstone will not receive 
information about the status of requests sent to that device. Because of this, the status for all requests 
will continue to appear as Requested even after the image has been captured. Use the procedure below 
to manually set the status to Complete so that you can filter the list on the Image Request and Results 
window and see which requests really are complete. 

To manually set a request to Completed: 

 On the Imaging Requests and Results window, right-click the request and select Force Complete. 

Note: You can only set pending requests to Complete. This feature is not available for Not Requested or 
Orphan statuses—you need to deal with those results as described in the section above. 

Image Request Special Action Item Report Filtered by Modality 
The Image Request Special Action Item Report has been updated in Cornerstone 8.3 to group invoice 
items by modality. The report provides a listing of service-type invoice items, by modality type, that have 
been set up to initiate the Image Request special action. Fields listed on the report include item ID, 
invoice item description, amount, modality, exam description, and any preselected shots associated 
with the item. This report is available in the Invoice Item report group. 

• Sort options for the report include invoice item description, invoice item ID, and invoice item 
modality. 

Cornerstone 8.3 What’s New                  74 



Modality Worklist Integration 

 

• Range options include invoice item description, invoice item ID and invoice item modality. 
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Electronic Signature Capture with Integrated Payment Solution 
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Solution 

The IDEXX Cornerstone* Practice Management System integrated payment solution in Cornerstone 8.3 
allows you to use a supported signature capture device or tablet PC to capture a client’s electronic 
signature for all credit card payments. This helps you have fewer paper receipts to manage. 

The IDEXX Cornerstone integrated payment solution, introduced in Cornerstone 8.1, offers a simple and 
secure solution for credit card processing initiated from Cornerstone. The third-party payment 
processing solution available in Cornerstone is XCharge®, developed by Accelerated Payment 
Technologies™: 

• Accepts all major credit and debit cards in the United States and Canada. 
• Is Payment Card Industry (PCI) compliant. 
• Meets all Payment Application Data Security Standard (PA-DSS) requirements. 
• Accommodates many workstations but only requires one Internet connection.  
• Provides meaningful management reports. 
• Processes partial payments, which provides flexible payment options for improved revenue. 

For detailed information on setting up and using the Cornerstone integrated payment solution with 
XCharge, see the Cornerstone 8.3 Administrator’s Manual and the Cornerstone 8.3 User’s Manual. 

Signature Capture Devices 
Supported signature capture devices include the Topaz® ClipGem®, Topaz SignatureGem® (SigGem), 
and Topaz SigLite® LCD devices, or a tablet PC.  

For information on purchasing a signature capture device or tablet PC, call IDEXX Practice Solutions for 
Supplies at 1-888-224-4408. If you have problems setting up your signature capture device, contact 
Cornerstone Support at 1-800-695-2877. 

Note: If a signature capture device will be used on a thin-client workstation, the device may need to be 
connected to an AnywhereUSB® device, depending on the type of signature capture device being used. 

Setup 

Adding a Signature Capture Device in Cornerstone  
As in previous versions of Cornerstone, the Signature Capture Device dialog box (Tools > Signature 
Capture Device) allows you to select the capture device model to be used with Cornerstone. See the 
Cornerstone Administrator’s Manual for further details. (This process has not changed in Cornerstone 
8.3.) 
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Enabling the Electronic Signature Capture Feature 
A new Enable Electronic signature capture check box on the Credit/Debit Payment Setup dialog box 
allows you to enable the electronic card payment signature functionality. Update a card payment type 
and click the Configure Payments Solution button). 

 

Note: Refer to the Cornerstone 8.3 Administrator’s Manual and the Cornerstone 8.3 User’s Manual for 
detailed information on XCharge setup and use with Cornerstone. 

Use 

Capturing the Client Signature at Payment Time 
Staff can now capture a client’s authorization for a credit card payment when making a payment on their 
client account or when posting an invoice.  

Note: The signature capture box displays differently in Cornerstone depending on whether you are using 
a signature capture device or a tablet PC. Also, Mobile Computing module users can capture signatures 
in the field and process a payment. 

Cornerstone 8.3 What’s New                  78 



Electronic Signature Capture with Integrated Payment Solution 

 

 
Credit card signature on a signature capture device 

 
Credit card signature on a tablet PC 

Posting an Invoice—Option to Print a Full Invoice or Invoice Receipt 
If you have enabled the Electronic Signature option in payment type setup and if Cornerstone detects a 
capture device and/or tablet, then a drop-down list is available on the Post Invoice dialog box. This drop-
down list is activated when you select the Print Invoice check box, and it lets you specify if you want to 
print the full invoice or an invoice receipt. A signature is printed on the invoice receipt, but it is not shown 
on the full invoice. 
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Identifying Signed Credit Card Transactions on the Patient Clipboard and the Client 
Account 

On the Patient Clipboard*, in the Client information area, the Account Information  tab displays the 

signature  icon for all credit card payments that have been electronically signed.  

 

The icon also displays to indicate electronically signed credit card payments on the Client Account 
window. 

  

Cornerstone 8.3 What’s New                  80 



Electronic Signature Capture with Integrated Payment Solution 

 

Changes to Payment on Account Report 
The Payment on Account Report now includes a copy of the client signature for electronically signed 
credit card payments. 
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Referral Relationship Management 

Overview 
Version 8.3 of the IDEXX Cornerstone* Practice Management System offers specialists in all disciplines 
a comprehensive solution for managing relationships with referring veterinarians (RDVMs). With these 
new referral management features, specialists and their staff can easily monitor the pulse of all activity 
relating to RDVMs and their patients. 

New referral management features allow you to: 

• Identify patients/clients referred by a particular RDVM. 

• Identify RDVMs associated with a particular patient. 

• Identify RDVMs associated with a particular hospital. 

• Quickly access notes about an RDVM’s education, interests, first referral date, etc. 

• Document and view RDVM/hospital communication preferences. 

• View RDVM and hospital communication preferences from the Patient Clipboard* window. 

• Search for RDVMs/hospitals using common filters including name, city, phone, or fax number. 

In addition, Cornerstone 8.3 features two new referral reports and enhancements to several existing 
referral reports. 

Use 

Finding and Viewing Referral Veterinarian Information on the Doctor List 
Using the enhanced Doctor List window (Lists > Referrals > Doctors), you can quickly find a referral 
veterinarian (RDVM) using common search filters such as name, doctor ID, phone, or fax number. 

 

You can click the phone icon to access all personal and hospital-affiliated phone and fax numbers for 
the RDVM within the Doctor List window. The primary contact number is indicated for both personal and 
hospital numbers. 
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Adding, Editing, and Viewing Referral Veterinarian Information on the Doctor 
Information Window 

Hospitals Tab 

The Doctor Information window’s Hospitals tab allows you to: 

• Associate one or more hospitals with the RDVM (an RDVM must be associated with at least one 
hospital). 

• Add or edit the preferred contact phone numbers, email, and fax information for this doctor at a 
selected hospital. 

• Indicate the RDVM’s communication preferences and contact information to use when at a selected 
hospital. 

Note: The Email communication preference will be selected automatically if the hospital’s Send info via 
field was set to Email prior to installing Cornerstone 8.3. 

 
 

Personal Information Tab 

The Doctor Information window’s Personal Information tab allows you to: 

• Specify if you want to display the doctor’s contact information on the Patient Clipboard based on 
Personal preferences (those selected on the Personal Information tab), Hospital related 
preferences (those selected on the Hospitals tab), or both. 

Cornerstone 8.3 What’s New                  84 



Referral Relationship Management 

 

• Add or edit personal contact information for this doctor. 

• Indicate the doctor’s personal communication preferences. 

Note: The Email communication preference will be selected automatically if the Send info via field was 
set to Email prior to installing Cornerstone 8.3. 

 
 

Patients Tab 

The Doctor Information window’s Patients tab allows you to: 

• View checked in/checked out patients referred by the RDVM. 

• Double-click to open the Patient Clipboard for a patient on this tab. 
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Sales Tab 

The Doctor Information window’s Sales tab allows you to: 

• View the monthly sales generated based on referrals from this RDVM. 

• View number of new patient referrals and recheck referrals for each monthly sales period. 
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Notes Tab 

The Doctor Information window’s Notes tab allows you to: 

• Add, edit, or view notes associated with this RDVM. 

• See the date of the first referral associated with this RDVM. 

 
 

Finding and Viewing Referral Hospital Information on the Hospital List 
Using the enhanced Hospital List window (Lists > Referrals > Hospitals), you can quickly find a 
referral hospital using common search filters, such as city, phone, or fax number. 

 

When you highlight a hospital on the Hospital List, the hospital’s address, phone, and fax information 
display at the bottom of the window. 

Adding, Editing, and Viewing Referral Hospital Information on the Hospital 
Information Window 

Information Tab 

The Hospital Information window’s Information tab allows you to: 
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• Add or edit contact information for this hospital. 

• Indicate the hospital’s communication preferences. 

 

 

Doctors Tab 

The Hospital Information window’s Doctors tab allows you to: 

• View referral veterinarians (RDVMs) associated with this hospital. 

• Open the Doctor Information window for a doctor by double-clicking a listed RDVM (or by clicking 
the View details link near the bottom of the window for a selected RDVM). 
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Patients Tab 

The Hospital Information window’s Patients tab allows you to: 

• View checked in/checked out patients referred by an RDVM at this hospital. 

• Double-click to open the Patient Clipboard for a patient on this tab. 

 

 

Sales Tab 

The Hospital Information window’s Sales tab allows you to: 

• View the monthly sales generated based on referrals from this hospital. 

• View number of new patient referrals and recheck referrals for each monthly sales period. 
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Notes Tab 

The Hospital Information window’s Notes tab allows you to: 

• Add, edit, or view notes associated with the referral hospital. 

• See the date of the first referral associated with this hospital. 

 

 

Accessing Referral Information and Referral History in Patient Information 
The Patient Information window’s Referrals tab has been enhanced to serve as a dual-purpose tab, 
allowing you to view both referral veterinarians (RDVM) and hospitals for a patient and the referral history 
of that patient.  

You should verify the RDVM information for a patient for each visit or case and update it as necessary.  

Referrals Tab—Patient RDVMs View 

The Referrals tab–Patient RDVMs view allows you to: 

• Identify RDVMs associated with this patient for this visit. 

• Specify a primary RDVM to be associated with this patient on the Patient Clipboard, in referral 
history, and on referral revenue reports.  

• Specify if an RDVM should be included on communications associated with this visit (using the This 
visit check box). The This visit check box is automatically selected for the primary RDVM, but you 
can clear the check box if the client has requested that the primary RDVM not receive 
communications. For more information about communications and an example using RDVMs, see 
“Emailing or Faxing Documents from the Cornerstone Editor” on page 20. 

• View communication preferences for a selected RDVM and hospital and associated contact 
information. 

• View the RDVM history for the patient. 

Note: When viewing the Referrals tab in Referral History view, click the view RDVMs for this patient link 
to switch the tab to Patient RDVMs view. 
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When an RDVM is selected, the associated communication preferences are listed in the box at the 
bottom of the tab. Use the scrollbar on the right side of the box to scroll through the available 
communication preferences: 

• Personal—Displays the RDVM’s personal communication preferences. If you want to view detailed 
personal contact information for this RDVM, click the view details link on the right to display the 
information on the Doctor Information window’s Personal Information tab. 

• When at [hospital name]—Displays the RDVM’s communication preferences when at the hospital 
selected above. If you want to view detailed hospital contact information for this RDVM, click the 
view details link on the right to display the information on the Hospitals tab in the Doctor 
Information window. 

• Hospital: [hospital name]—Displays the selected hospital’s communication preferences. If you 
want to view detailed contact information for this hospital, click the view details link on the right to 
display the information on the Information tab in the Hospital Information window. 

 

Referrals Tab–Referral History View 

The Referrals tab—Referral History view allows you to: 

• View complete referral history for this patient, including the date when the primary RDVM/hospital 
was assigned to this patient. 

Note: When viewing the Referrals tab in Patient RDVMs view, click the view referral history link to 
switch the tab to Patient History view. 
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Accessing Referral Information on the Patient Clipboard* Window 

Patient Information  

In addition to an updated layout to accommodate quick “at a glance” scanning, the Patient information 
area now includes information on the patient’s primary referral veterinarian (RDVM), the RDVM primary 
phone number, and a link to view more RDVMs for this patient (or a link to add an RDVM if one has not 
been assigned for this patient). 

 

 

RDVMs Tab 

The Patient Clipboard Referrals tab in the Patient information area has been renamed the RDVMs 

(Referral Veterinarians) tab in Cornerstone 8.3. Click the RDVMs button  to access the tab. If you 
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upgraded to Cornerstone 8.3 from an earlier version of Cornerstone, the most recent RDVM is listed as 
the primary RDVM for each patient. 

• The RDVMs tab lists the patient’s current RDVMs and their associated hospitals. 

• The RDVMs tab right-click menu provides quick access to detailed referral information and contacts 
for this patient. 

 

When an RDVM is selected on this tab, the associated communication preferences are listed in the box 
at the bottom of the tab.  

• Use the scrollbar on the right side of the box to scroll through the available communication 
preferences. 

• Click the view details link to access detailed contact information. 

Note: The communication preferences that display here vary depending on the Patient Clipboard 
display preferences selected for the RDVM on the Personal Information tab in the Doctor Information 
window.  
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Referral Information on the Patient Check-in/out Window 
New options added to the Patient Check-in/out window Cornerstone 8.3 make it easy to identify and 
assign RDVMs. 

On the Patient Check-in/out window, if a primary RDVM has been assigned for this patient, the RDVM is 
listed. In addition, the add/edit RDVMs link opens the Patient Information window’s Referral tab, 
allowing you to: 

• Add a new RDVM for this patient. 

• Access information for an existing RDVM. 

• Specify a primary RDVM for the visit by selecting the Primary option. 

• Specify the RDVMs you want to receive communications associated with this visit by 
selecting/clearing the This visit check box for each listed RDVM. The RDVM must have 
communication preferences set up in Cornerstone for the information to automatically appear in the 
Communications window.  
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Referral Information for Mobile Computing  
RDVM information is enabled and viewable via hyperlinks for Mobile Computing module users. Click the 
links to open a read-only view of the Patient Information > RDVMs tab. There are also two new options 
available when you right-click in the Patient Information > RDVMs tab (View all Patient RDVMs and 
View Referral History). 

New and Enhanced Referral Reports 
New Reports 

EOM Referral Revenue Report by Doctor by Revenue Center 

 

 

EOM Referral Revenue Report by Hospital by Revenue Center 

 

These new referral reports display the work done by a staff member of your practice for a referring 
doctor/hospital. 
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Report fields include: 

• Referral Doctor/Hospital 

• Revenue Center Client ID 

• [Client] Name 

• New—Total number of invoices with referral patients where the patient was not checked in using the 
referral recheck option. 

• Rechecks—Total number of invoices with referral patients where the patient was checked in using 
the referral recheck option. 

• Total Visits—Total number of invoices for both new and recheck visits. 

• Sales—Total net sales for client’s referral patients. 

• Total for Revenue Center—Sums for new visits, recheck visits, total visits and sales for each revenue 
center. 

• Total for Doctor—Sums for new visits, recheck visits, total visits and sales for each referring 
doctor/hospital. 

• Extra fields included when saving to a file—Patient ID, Invoice ID, and Practice 

 

Enhanced Reports 

New ranges are available for existing End of Month referral reports: 

• Referral Revenue Report by Revenue Center by Doctor by Hospital 

• Referral Revenue Report by Revenue Center by Hospital by Doctor 

• Referral Summary by Revenue Center—Doctor by Hospital 

• Referral Summary by Revenue Center—Hospital by Doctor 

• Referral Doctor Master Report 

• Referral Hospital Master Report 

 

Enhancements have been made to several existing referral reports: 

• Referral Summary by Doctor 

• Referral Summary by Hospital 

• Referral Report by Staff 
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Inventory 

Enhancements to Cornerstone* Inventory Windows 

Electronic Inventory Ordering with IDEXX SmartOrder* and MWI® Veterinary 
Supply 
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Many of the main IDEXX Cornerstone* Practice Management System Inventory windows have been 
updated with a new look and feel, including new labels and text, so that you can more quickly and easily 
navigate them. In addition, the updated windows include new sort options and new show/hide column 
settings for displaying invoice item grids. 

Notes: 

• The inventory windows require that Windows® Internet Explorer® 7 or later be installed on each 
workstation. It does not have to be used as the default Internet browser. 

• If you use the Mobile Computing module, your main Cornerstone Inventory windows will look 
unchanged. 

Use 

Want List 
To access the Want List, on the menu bar, select Inventory > Want List or click the Want List button 

 on the Cornerstone toolbar. 

 

In Cornerstone 8.3, the Want List has been reorganized to make it easier to distinguish between 
inventory and non-inventory items. When adding an item to the Want List, you must specify if the item is 
an inventory item with an existing item ID or without an ID in Cornerstone. 

• If the want item is an inventory item, leave the Inventory item check box selected and type the item 

ID in the Item ID text box or press F2 (or click ) to search for and select the ID from the Search 
for Inventory Item dialog box (see “Search for Inventory Item” on page 102 for more information). 
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• If the want item is not an inventory item, select the Not an inventory item check box and type a 
description. The item will appear on the Want List without an item ID. 

Purchasing Work List 
The Purchasing Work List window has been updated with several improvements to fields, on-screen text, 
and grid navigation/display options.  

To access the Purchasing Work List, on the menu bar, select Inventory > Purchasing Work List.  

 
Single Location Inventory 

 

 
Multi-Location Inventory 
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Major updates to the Purchasing Work List window include: 

• Added a new add to Want List link that opens the Want List dialog box. 

• Replaced the Want List icon that displays in the left-most column on the grid next to an item if the 
item came from the Want List. The  icon matches the Want List button on the Cornerstone 
toolbar. 

• Enhanced the invoice item grid navigation, display, and sort options (see “New Invoice Item Grid 
Sort and Display Options” on page 104 for information). 

• Renamed the Delete button; it is now the Remove From List button. 

• Changed the way you expand/collapse the item information tabs available at the bottom of the 
Purchasing Work List window. Click the new More Item Information For bar to switch between 
showing and hiding the item information tabs.  

Purchase Order List 
The Order List window has been updated with several improvements to fields, on-screen text, and grid 
navigation/display options. 

To access the Purchase Order List, on the menu bar, select Inventory > Order List. 

 

 
 

Major updates to the Purchase Order List window include: 

• Enhanced the invoice item grid navigation, display and sort options (see “New Invoice Item Grid Sort 
and Display Options” on page 104 for information). 

• Renamed the Receive Now button; it is now the Receive Order button. 
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Create Purchase Order 
The Add a New Purchase Order window has been renamed the Create Purchase Order window. It has 
been updated with several improvements to fields, on-screen text, and grid display options. 

To access the Create Purchase Order window, select Add New Order on the Order List window or click 
Add to add selected item(s) to an order from the Purchasing Work List. 

 

 

 

Major updates to the Create Purchase Order window include: 

• Added additional on-screen tip text that displays on the right side of the window. 

• Enhanced the invoice item grid navigation, display, and sort options (see “New Invoice Item Grid 
Sort and Display Options” on page 104 for information). 

• Replaced the Notes icon that displays in the right-most column on the grid with a new icon: . 

• Changed Total value label to Total cost (displays below invoice item grid). 

• Replaced the Back button with a Cancel button and replaced the Delete button with a Remove from 
Order button (displays below the invoice item grid, next to the total cost). 

• Made changes to the item information area that you can show/hide at the bottom of the window (see 
“Item Information Tabs” below for information). 

• Included fulfillment and support information when placing orders online through IDEXX SmartOrder* 
with MWI Veterinary Supply. 

Item Information Tabs 
As in earlier versions of Cornerstone, a group of expandable tabs provides information for inventory 
items marked Maintain Quantity on Hand (QOH). The tabs are available at the bottom of many 
Cornerstone Inventory windows. 
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In Cornerstone 8.3, the method used to show/hide the tabs has changed. To switch between 
showing/hiding the tabs on an applicable Cornerstone Inventory window, click the More Item 
Information For [item description] or Information bar to view/hide item information tabs for the 
selected invoice item. 

 

Updates to the More Item Information or Information tab include: 

 Improved the item statuses displayed in the Item History tab. The Transaction column provides 
detailed information on the order status of the selected invoice item.  

 

Search for Inventory Item 
When accessed from the Want List, Create Purchase Order, or Purchasing Work List windows, the 
Search for Inventory Item dialog box appears in an enhanced display and includes new filtering options. 
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Major updates to the Search for Inventory Item dialog box include: 

• Added Vendor and Vendor Item ID fields. 

• Added a Search for a word check box and removed the Keyword filter in the advanced search 
options. 

• Changed Item ID filter to suggest search matches as you type; matches include all IDs that contain 
the typed ID characters in the given order.  

• Removed Advanced search button (advanced search options are permanently included on the 
dialog box).  

• Added Search vendor item IDs (only) check box, which filters your invoice item search based on 
vendor item IDs.  

• Added a Reset button, which restores the default search filter settings. 

• Enhanced the invoice item grid navigation, display, and sort options (see “New Invoice Item Grid 
Sort and Display Options” below for information). 

• Added navigation buttons (at bottom of invoice item grid). Click the First arrow button to display the 
first page of invoice items, the Previous and Next arrow buttons to move to the previous or next 
page of items, and the Last arrow button to move to the very last page of items.  

• If you want to change the number of items displayed on each page, select an option from the 
Results per page drop-down list (bottom right). 

• Replaced the grid’s Quantity on Hand icon from the previous flag icon to , indicating that 
quantity on hand is tracked for the item. 

• The method used to show/hide the Add an item area has changed. To switch between 
showing/hiding these fields, click the Add an Item bar. This is a new feature for Single Location 
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Inventory users. Tip: The % character can be used in the Description field as a wildcard character 
to enhance searching by adding it before or after a word. 

New Invoice Item Grid Sort and Display Options 
Many Cornerstone Inventory windows updated in Cornerstone 8.3 feature a new invoice item grid that 
provides enhanced sort and display settings (selected columns, column order, sort order, etc.) that you 
can change based on your preferences for viewing the information. 

To rearrange columns within a table: 

 Click and drag a column header (column name) to the left or 
right to move it to the desired location within all currently 
displayed columns. 

To change the table sort order: 

1. If you want to change the order in which information is displayed in 
a table, click the name of the column by which you would like to sort the 
table. A small triangle displays to the right of the column name to 
indicate the column used for the current sort order. 

2. Click the same column header again to reverse the sorting order.  

Note: You can also right-click a column header and select Sort 
Ascending or Sort Descending to set the sort order for a table. The Search for Inventory Item dialog 
box contains a subset of the search options that are listed in the right-click menu.  

To change the table display using the right-click menu options: 

Right-click a column header and select one of the following menu options: 

• Columns (allows you to select/deselect columns to display in the table) 

• Group by [column header] 

• Freeze/Unfreeze [column header]
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Inventory Solution and MWI® Veterinary Supply 

New IDEXX SmartOrder* electronic inventory ordering in Cornerstone* 8.3 allows for a more efficient 
inventory work flow with real-time online inventory ordering through MWI® Veterinary Supply. Two of the 
industry’s leading systems, Cornerstone and MWI, now integrate with each other to provide a unique 
inventory management solution that is virtually seamless. Using the IDEXX SmartOrder connection, 
orders placed within Cornerstone receive real-time inventory status updates and pricing updates from 
MWI. Order tracking is provided once MWI has processed an order and as orders are shipped. In 
addition, Cornerstone automatically recognizes the receipt of the shipment.  

Benefits of IDEXX SmartOrder include: 

• Ordering from within your practice management system—The order process is within your work 
flow so you do not have to switch among multiple systems to place or track an order. 

• Real-time pricing details—When you place an order cost for that item is displayed in the purchase 
order. In addition, when quantity discount opportunities are available, a notification is visible in the 
SP (Special Pricing) column of the purchase order. 

• Immediate notification of item availability—You will know right away if items are on back order.  

• Item status updates—Orders can be tracked from the time they’re placed to the time they arrive at 
the practice. 

• Automated electronic receipt of items—As ordered items arrive at the practice, receipts are 
automatically populated with the appropriate information for quick and easy processing. 

Note: Windows® Internet Explorer® 7 or later must be installed on each Cornerstone workstation. It does 
not have to be the default Internet browser. 

Setup 

Setting Up Electronic Inventory Ordering with MWI Veterinary Supply 
For IDEXX SmartOrder to seamlessly connect to the MWI online inventory ordering system, you must 
complete a one-time setup to specify your account information and agree to the MWI terms of sale. This 
will allow you to send and receive orders from MWI without needing to log in to their website for each 
online transaction. 

Notes:  

• You must have an account set up with mwivet.com to use IDEXX SmartOrder. If you do not have an 
account set up, contact your MWI representative. 

• New MWI customers must contact MWI to set up your account and activate online ordering with 
mwivet.com. If you do not have an account set up, contact your MWI representative. 

• Existing MWI customers can use their current MWI customer number to activate electronic 
inventory ordering in Cornerstone, but you must also contact MWI to enable online ordering 
through MWI. 
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• There is a $99 annual service fee for IDEXX SmartOrder; however, this fee will be waived by MWI for 
any practices that place annual orders totaling $5,000 or more directly through the IDEXX 
SmartOrder inventory ordering system within Cornerstone.  The annual tracking period will begin on 
the date that you activate IDEXX SmartOrder within Cornerstone. 

To use the service, you must: 

• Have or establish an account with MWI at mwivet.com.  

• Set up electronic inventory ordering in Cornerstone and accept the MWI terms of agreement. 

• Have a consistent, high-speed Internet connection. 

To access Login/Password Management settings: 

1. On the Lists menu, select Practice. The Practice List dialog box appears. 

2. With your practice name selected, click Update (or double-click the practice). The Practice 
Information window appears. 

To set Login/Password Management account settings for MWI Veterinary Supply: 

Only an administrator can set up and modify electronic inventory ordering with IDEXX SmartOrder. 

1. On the Practice Information window, in the Login/Password Management area, select Vendor–MWI 
Veterinary Supply from the drop-down list. 

2. From the Associated Cornerstone Vendor drop-down list, select the practice-specific vendor 
associated with MWI to use for this service. 

3. In the Customer Number text box, enter your practice’s MWI customer number. You can find this 
information on your mwivet.com account. 

4. Select the Enable Online Ordering check box. 

5. A pop-up box displays the terms and agreement. Review the terms and click Accept to activate the 
service. 

6. When you are notified that activation was successful, click OK.  

7. Click Test to verify that you have a working Internet connection and valid login information for 
accessing the vendor’s online ordering system.  
In the Practice Information window, the user acceptance, date/time stamp, and a link to the MWI 
terms and agreement is displayed when online ordering is enabled.  
Note: You have now setup Cornerstone for online ordering. If you have not contacted  
MWI E-Commerce Support to activate online ordering with MWI, you must do so before you can 
begin placing orders. If you have not activated online ordering and place an order through 
Cornerstone, it will not be processed and you will not receive your order.   

Note: Multi-Location Single Database (MLSD) configuration only—The primary practice reviews and 
agrees to the MWI terms of sale on behalf of all locations within the MLSD group. An administrator must 
set up each secondary practice by following steps 1-4 above. Each secondary location can click the 
Apply Primary Practice Settings button to use those settings or enter its own MWI customer number (if 
applicable). The user acceptance, date/time stamp, and a link to the MWI terms of sale agreed to by the 
primary practice are displayed for both primary and secondary practices when online ordering is 
enabled.  
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Disabling Electronic Inventory Ordering with MWI Veterinary Supply: 
1. On the Lists menu, select Practice. The Practice List dialog box appears. 

2. With your practice name selected, click Update (or double-click the practice). The Practice 
Information dialog box appears. 

3. On the Practice Information window, in the Login/Password Management area, select Vendor–MWI 
Veterinary Supply from the drop-down list. 

4. Clear the Enable Online Ordering check box. 
Note: If you have open orders, a message indicating that you cannot disable online ordering until all 
orders are closed appears.  

5. If you have no open orders, click Yes when the message confirming your intent to disable online 
ordering appears.  

6. A message informing you that you have disabled online ordering in Cornerstone appears. To 
complete your MWI unenrollment, you must contact MWI E-Commerce Support: 

MWI E-Commerce Support 

• Phone: 1-888-562-3405 

• Email: ise-commerceteam@mwivet.com  

Reactivating Electronic Inventory Ordering with MWI Veterinary Supply 
If you have disabled your enrollment with MWI, you must first contact MWI E-Commerce Support (see 
above) to establish or reactivate your account. Then, follow the setup instructions above to reactivate 
online ordering within Cornerstone. 

Use 

Creating an MWI Purchase Order in Cornerstone  

To create a purchase order for MWI: 

1. Access the Create Purchase Order window from either the Purchase Order List or Purchasing Work 
List window. 
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2. On the Create Purchase Order window, select MWI Veterinary Supply or your practice-specific 
associated vendor for MWI as the vendor. 

3. In the invoice item grid, in the ID field, type the item ID and press TAB, or press F2 to search for and 
select an item from the Search for Inventory Item dialog box. 

Once an item has been entered in the grid, Cornerstone performs a real-time check to verify the 
following: 

• Item has a matching MWI vendor item ID 

• Ordered quantity is available 

• Item cost 

• Any available quantity discounts 

Note: An invoice item line marked “Back order” displays if the item is on back order with the 
selected vendor. Contact MWI directly to check on expected date of availability. 

4. A link for the MWI fulfillment and support terms of sale is displayed on the right side of the Purchase 
Order List window. Click the link to review the order. You can also click the link to review MWI’s 
terms and conditions. 

 

5. Select Place Order. 

Notes:  

• When you place an order through IDEXX SmartOrder, the order is sent to MWI for fulfillment. MWI is 
fully responsible for fulfillment of your order, including providing customer support related to your 
order. 

• If you have a credit card on file at MWI and are set up to be billed by credit card, you will be billed 
when you place the order. You will not be able to pay by credit card when you receive the order. 
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If you have questions regarding your order, contact MWI: 

MWI Customer Support 

Phone: 1-888-562-3405 

Email: ise-commerceteam@mwivet.com  
(email received after hours will be answered on the next business day) 

Website: www.mwivet.com 
Business hours: Monday–Friday, 8:00 a.m.–8:00 p.m. 

Adding Vendor Item IDs for Matching Inventory Items in Cornerstone  
When adding items to a purchase order, if an invoice item is not recognized by MWI or if the invoice item 
does not have an associated MWI vendor item ID in Cornerstone, the invoice item line will display with a 
yellow background and an alert message box appears. 

At this point, you may either remove the item from the order or double-click the item’s description to 
open the Suggested Item List dialog box and select a suggested MWI item ID match for the item.  

On the Suggested Item List dialog box, Cornerstone automatically populates the Description field with 
the invoice item’s description in Cornerstone. Click Search to find any closely matching MWI item 
descriptions. If you are unable to locate a matching item, you can refine search terms or change the 
description to one or more words that may be recognizable and click Search again. If you select the 
MWI item as a match, the MWI vendor item ID is automatically applied to the Cornerstone item. This item 
will now be available for online ordering from Cornerstone in the future.   

Note:  If you make a mistake mapping your item ID to the MWI item ID, you will not be able to assign 
that MWI vendor item ID. To remove the incorrect mapping, select Lists > Invoice Item and search for 
the item. Click Update. On the Inventory tab, click Item Vendor and delete the vendor item ID on the 
grid.  

Assigning Multiple Vendor Item IDs to a Single Inventory Item ID  

You can set up multiple vendor item IDs for a single product as long as you use the same buy/sell ratio 
for each vendor item ID.  

For example, you might have more than one vendor for amoxicillin 50 mg capsules. With both vendors, 
you buy in bottles of 50 capsules but sell individually. In this case, you could set up a vendor item ID for 
each vendor and link both vendor item IDs to the same inventory item ID.  

 Buy Sell Example 
Inventory Item 
ID 

Example 
Vendor Item 
ID 

Vendor A Bottle of 50 Single tablet 1001 204 

Vendor B Bottle of 50 Single tablet 1001 573 

Adding a Vendor Item ID While Working with Inventory Orders 
You can add a new invoice item when searching for an item on the Search for Inventory Item dialog box. 
The enhanced Search for Inventory Item dialog box in Cornerstone 8.3 now includes new Vendor and 
Vendor Item ID fields that provide a quick way to add the primary vendor/vendor item ID information for 
the item. 
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Note: The alternative method for adding vendor and vendor item ID information for an item is as follows. 
Select Lists > Invoice Item, and then click Update. On the Inventory tab, click Item Vendor, and then 
type the vendor and vendor item ID in the applicable fields in the grid (scroll horizontally to access the 
Vendor item ID field). 
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Tracking Order Statuses from Cornerstone  
New order tracking features for electronic inventory orders allow you to: 

• See when the status of an ordered item changes, indicating if the order was sent, if the vendor 
received the order successfully, etc. 

• If the order is received successfully by MWI, the status is Sent – Online. 

• If the order is not received by MWI, you will see a message asking you to complete the 
order offline, and the status is Sent. If this happens, you need to use another method to 
send the order, such as sending by the order by fax or calling MWI. 

 

• Track individual invoice items in the order by clicking the Track link. This link launches the 
associated website (USPS, UPS®, or FedEx®) to access tracking details. The link appears on the 
purchase order once MWI has completed processing and shipped the item. 

• After submitting your order, you will receive a confirmation notice informing you that your order has 
been placed with your practice’s associated vendor for MWI, along with a confirmation number for 
use in the event you have to contact MWI. 

Synchronization of Electronic Inventory Orders with MWI 
If you are set up to use IDEXX SmartOrder with MWI online inventory ordering, Cornerstone checks MWI 
online orders to detect unmatched orders.  

Unmatched purchase orders are created when you manually create an order—for example, if you place 
an order online, by phone, or by fax. Duplicate unmatched orders are created if you begin an order 
using IDEXX Smartorder in Cornerstone but need to complete the order manually. (This might happen if 
Internet connectivity issues prevent you from completing an order through Cornerstone.) In a duplicate 
unmatched order situation, synchronize the manually created purchase order, and then use the Delete 
button to delete the original purchase order created in Cornerstone. 

You can view unmatched purchase orders in the Unmatched Orders area on the right of the Purchase 
Order List window, and use the following procedure to create matching purchase orders for them. This 
synchronizes the electronic inventory orders from MWI with Cornerstone and adds them to the Purchase 
Order List window. 

If you start an order in Cornerstone but Cornerstone is not able to connect with MWI, a message 
appears telling you that you need to complete the order offline. After you place this order (for example, 
by phone or fax), Cornerstone detects it as an unmatched order. However, because a purchase was 
already created before the Internet connectivity problem occurred, you need to follow a special 
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procedure to synchronize this kind of unmatched order. Otherwise, an extra, duplicate purchase  
order will remain in Cornerstone. (See “To synchronize an order started in Cornerstone but  
completed offline,” below.) 

To synchronize electronic inventory orders with MWI: 

1. Select the view all link to open the Unmatched Purchase Orders window. 

2. Select an order in the top grid to view the invoice items on that order in the bottom grid.  

3. For any invoice item that does not have an associated Cornerstone inventory item ID, add the ID in 
the appropriate field in the Inventory Item column. All invoice items must have associated 
Cornerstone inventory item IDs for the order to be reconciled and created. 

Note: See “Adding Vendor Item IDs for Matching Inventory Items in Cornerstone” on page 109 for 
more information. 

4. When each line item has been matched to an associated inventory item in Cornerstone, click Save 
to create the purchase order in Cornerstone. The Unmatched Purchase Orders window closes, and 
the purchase order appears on the Purchase Order List window. 

To synchronize an order started in Cornerstone but completed offline: 

1. Select the view all link to open the Unmatched Purchase Orders window. 

 

2. If you know that the order listed is a duplicate, select it and click Delete to use the original purchase 
order from the Purchase Order List.  
Tip: The original purchase order has a lower purchase order number. 
OR 
If you decide to synchronize the unmatched order, follow the “To synchronize electronic inventory 
orders with MWI” above. 
Note: You must close the original purchase order in the Purchase Order List after you have 
synchronized the new unmatched order.  
To close an order: 

a. On the Purchase Order List, select the purchase order that was originally created for this order. 

b. Click Close Order. The status changes to Closed. 

c. Click Delete. The original purchase order is removed from the Purchase Order List. 
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Receiving Orders 

To receive an order: 

1. Select Inventory > Order List. The Purchase Order List opens. 

2. Select the purchase order and click Receive Order. 

3. Type the receipt number for your order in the Receipt Number box. The item list displays.   

4. Review the order for completeness and update the status by either clicking Receive All or by 
selecting Received from the Status drop-down list for each item.   

5. Missing order information (e.g., lot number) is in red text. You must update this information before 
you can post the order. Click Receipt Item Details to fill in the remaining fields. 

6. Click Post. 

7. In the Change Prices window, make any final adjustments and view the current and new pricing, if 
applicable. 

8. When finished making any changes, click Post. 
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Login/Password Management 
Cornerstone* 8.3 software includes new Login/Password Management features that allow you to set and 
manage practice-wide settings for accessing a variety of features and services from the IDEXX 
Cornerstone* Practice Management System. 

These new settings are located on the Practice Information window (from the Lists menu, select 
Practice, and then double-click a practice name).  

 
Note: If a Multi-Location Single Database configuration has been activated, the settings available may 
differ based on whether you are updating settings for the primary practice or for a secondary practice. 

Login/Password Management configuration is required for the following features and services. 

• Email communications 

• Fax communications using the IDEXX Faxing Service† 

• Veterinary supply vendor—electronic inventory ordering† 

• VetConnect PLUS 

• Antech Reference Labs† 

Note: Some of the above features and services (noted above with a † dagger) require purchase of a 
separate Cornerstone module or service. 
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New Database and Services Management Window 
To support the new features in version 8.3, the Cornerstone software runs a number of new IDEXX 
services in the background on your computer. The IDEXX Database and Services window allows you to 
monitor the coordination of these services with each other and with your Cornerstone database.  

Beginning with Cornerstone 8.3.6, you will notice some differences in the way the database and services 
are handled. For more information about the database and services in previous versions of Cornerstone 
8.3, see the latest release notes. 

• Cornerstone services are started and stopped in the IDEXX Database and Services window, which 
allows you to monitor the coordination of these services with each other and with your Cornerstone 
database. This window runs in the background. If you want to open the window to see which 
services are running, follow the instructions below. 

• The Cornerstone database runs as a service. This means that you no longer have to start the 
database. It starts automatically when you open Cornerstone. 

• You will NOT see a database icon in the system tray as you may have in previous versions of 
Cornerstone. 

To open the IDEXX Database and Services window: 

1. Double-click the Cornerstone Database Server  icon on your desktop. The IDEXX 
Database and Services window appears. 

 
Services that are running display Running in green text. Services that are stopped display 
Stopped in red text. 

2. To start or stop all the services, click Start All or Stop All.  

A list of stopping or starting activities will appear in the window. The word Finished appears 
when the action is complete. 

Note: You can start and stop individual services. Click Open Windows Services, locate the 
service, and right-click to start or stop the service. We do not recommend that you do this as 
services are started and stopped automatically in the correct order. 

3. Close the window. 
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Additional Changes and Enhancements 
The changes listed below were made as part of the initial Cornerstone 8.3 release. The changes that 
have been made in 8.3 service packs are available in the latest release notes. 

Medical 

• Staff with appropriate security permissions can now make corrections to a vaccine tag (on the 
Patient Clipboard, right-click the tag and select Correct). 

• When reissuing a vaccine tag, the old tag number is voided and remains viewable in Cornerstone for 
reference purposes. 

• The first line of an enhanced medical note is not automatically included as part of its History 
Description. 

• When a Pick List item is added to a medical note template, the Pick List item correctly displays when 
the medical note is opened. 

• If invoice items included in a medical note template are reordered, the order is retained after saving 
the template. 

• Including more than one Pick List item in a medical note no longer causes issues. 

• In enhanced medical notes, you can now paste the same piece of text into a note more than once.  

• When you use a document template that contains a pick list by default, duplicate documents are no 
longer created and the pick list item is reflected on the Patient Visit List correctly.  

• When the Electronic Whiteboard window is minimized and then restored, it displays the current time 
(no longer resets to midnight). 

• The Patient Treatments window updates more quickly when the main Whiteboard is open behind it.  

• When setting up a medical note or correspondence template, you can place text in a frame/text box 
on the side of the page and the contents in the body of the document wrap around the box. 

• Entering/selecting a staff ID when entering vital signs for a patient no longer causes issues. 

• Entering vital signs for a patient belonging to an inactive client no longer causes an error. 

• For a quicker way to add attachments directly to enhanced medical notes or correspondence, from 
the Patient Clipboard* or Patient File window, right-click the title of the document that you want to 
attach additional information to and use the menu options to add or edit attachments. This feature is 
available only for enhanced medical notes and correspondence in a state of Tentative or Draft.  

Laboratory 
• Updated the IDEXX Reference Laboratories (U.S.) Directory of Services with 2012 pricing and new 

testing features.  

• Introduced GREER® Aller-g-complete® allergy testing through IDEXX Reference Laboratories to test 
and treat atopic canine, feline, and equine patients with serum allergy testing and immunotherapy.  

• Support for future release of IDEXX VetLab* Station 3.30 software update, which will introduce 
additional testing options, including: 

• IDEXX ProCyte Dx* Hematology Analyzer can identify the presence of Band Neutrophils 
(canine, feline, equine, and bovine) and nRBCs (canine and feline). 
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• Expanded species menu and support of body fluid analysis (abdominal and thoracic) for 
both IDEXX ProCyte Dx and LaserCyte* hematology analyzers. 

Reports 

• IDEXX Reference Laboratories Report PDF functionality has been restored.  

• The Inventory Audit Report correctly includes lot numbers for inventory items that are linked to 
service items. 

• The Controlled Substance Report correctly includes all invoice item information when the report is 
sorted by invoice item ID. 

• The Report Search window is no longer prevented from opening successfully under certain 
circumstances. 

• Color and client address have been added to the patient history report.  

• A row showing patient and sales information has been added to the Statistics by Staff Report for the 
end of all periods (day, month, and year). 

• The Invoice Item Sales Information Report has been revised: 

o The client name has been added. Staff is identified by ID. 

o The report can be filtered by revenue center. 

Imaging 

• You can select more than one image request at a time from all of the places where you can begin 
the image capture process. 

• For any telemedicine cases existing in patient history, the history line on the Patient Clipboard 
displays the word “RESULTS” when the telemedicine specialist report has been received. To view 
the report, click the line to view the report in the Preview pane or double-click to open the report in a 
separate viewing window. 

• As long as staff security is set appropriately, staff members set up with any role can delete individual 
images. Previously, administrators could delete individual images but staff in other roles could 
delete only complete image studies. 

• DICOM® images no longer appeared blank or inverted. 

• Reloading and retaking several shots in a large image study works correctly. 

• Editing and saving images if image storage options are set in a certain way works correctly. 

• The crop feature has been adjusted so that it is accurate if you crop down to an area that is 50% of 
the original image or smaller. 

• Clicking buttons on the Case Details window very quickly after the window appears works correctly. 

• Opening and submitting cases in practices with a large number of active staff members works 
correctly. 

• The Enable TWAIN UI check box on the Imaging configuration window has been restored. (Select 
Controls > Defaults > Imaging and select Imaging on the left.) This check box is used to set up 
some scanners and multifunction printers that use automatic document feeders. 

• Radiology log opens when you right-click the Patient Clipboard and select Imaging > Radiology 
Log. 
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• Images are sent more quickly using the Telemedicine tab on the Case Actions pane of the Case 
Detail window.  

• Eliminated orange tint that appeared when older images were viewed with the IDEXX I-Vision 
Mobile* application.  

• Importing DICOM files encoded in a certain way no longer causes Cornerstone to freeze. 

General 
• Enhanced Appointment Schedule suite setup options allow you to display 12 or 16 columns on the 

Schedule for Today window (in addition to the existing 4-, 6- and 8-column options). A widescreen 
monitor is recommended for the 12- or 16-column setup. 

• The Daily Planner window’s Call Backs tab correctly displays the complete client phone number 
when a line is highlighted on this tab. 

• When performing a purge of client data, Cornerstone correctly purges the Referred By client ID data. 

• Added ability to export data for state of Washington Controlled Substance Export program. (Contact 
IDEXX Cornerstone Support for instructions on using this functionality.) 

• When checking in an appointment from the Patient Clipboard with an associated secondary reason 
for visit, the secondary reason for visit is reflected on the Patient Clipboard and the Census List. 

• Changed Cornerstone services behavior to avoid issues with ODBC connections and access to 
shared folders. 

• Updated the Cornerstone Support phone number for Australia on the Help > About dialog box. 

• Made performance improvements to the Patient Clipboard to speed up display of the Vital Signs tab 
and patient history. 

• Restored the ability to view detail of a payment by right-clicking the payment on the Client Account 
Information tab of the Patient Clipboard and selecting View.  

• On newly created invoices, if you’ve chosen to calculate accounts receivable (A/R) by provider, and 
to apply payment to specific invoices for A/R by provider, the payment is credited properly.  

• To set this up, select Controls> Defaults> Practice and Workstation Defaults, and select 
Invoice in the menu on the left. In the A/R by provider area, select the Calculate accounts 
receivable by provider check box. 

• You can make invoice type mandatory for invoices. If an invoice type is not selected, the user will be 
prompted to select one. 

• To set this up, select Controls > Defaults > Practice and Workstation Defaults, and 
select Invoice in the menu on the left. In the Invoice area, select the Invoice type required 
check box.  

• On the Invoice Item Information window, in the Quantity/Amount/Markup table, fixed error that 
occurred if you left one row blank (or with only zeroes entered) and then tried to enter information in 
another row.  

• On monthly statements: 

• As before, client invoice lines are grouped with corresponding payments and discounts. 
Now, however, the information is shown with invoice first, then the discount, and then the 
payment.  
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• Voided payments on accounts are now properly filtered out of monthly statements.  

• On the Patient Orders window:  

• When you transfer an item from the Patient Visit List to the Patient Orders window and that 
item has several special actions of the same type, it no longer causes an error.  

• The Patient Orders window no longer locks up when it is open on more than one 
workstation at the same time.  

• No matter where you access a prescription from, a warning appears on the prescription for items 
that are set as controlled substances.  

• If you have an invoice set up with a vaccine tag special action, you are required to enter a vaccine 
tag number before you post an invoice containing that special action.  

• An error that occurred if you entered incorrect patient weight information, voided it, and then entered 
the correct weight no longer occurs.  

• Patient birthdates in the future are no longer allowed.  

• The Cook County Extract now includes results from the full date range. 

• You can now use an email address to search for a client on the Client List dialog box.  

• You can apply a discount to all the lines in an invoice. On the Transitions Discounts dialog box, 
select the Add line discounts to all lines for this patient check box. Note that proper security 
settings must be enabled to use this feature.  

• For Multi-location/Single Database (MLSD) only, the Client tab of the Client/Patient Report Builder 
includes an option to filter clients based on home practice. 
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